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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-
ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE
TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO
NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN
THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN
30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A
REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a
single computer. You may physically transfer the SOFTWARE from one computer to
another provided that the SOFTWARE is used on only one computer at a time. You shall not
install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any
other hardware configuration where the SOFTWARE is accessible to more than one CPU or
to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE
USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING
LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN
WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes,
or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your
computer and retain the original for back-up purposes. Any other copying of the
SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright
notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support
for use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions
or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS
LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-
ROM storing the SOFTWARE is warranted only against defective material under normal use
for a period of ninety (90) days after purchase from an authorized Canon dealer as
evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be
replacement of the same without charge when returned by you at your expense to your
point of purchase and proven to be defective upon inspection. The replacement CD-ROM
will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM
resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to
anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
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READ CAREFULLY BEFORE USING!

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT
LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE
INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED
OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE
THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect
until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You
may terminate this Agreement by destroying the SOFTWARE. This Agreement will also
terminate without notice to you if you fail to comply with any of the terms of this Agreement
and you must then promptly return the SOFTWARE. In addition, Canon may enforce its
other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer
Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the
Software in the United States of America shall be governed and construed in all respects in
accordance with the laws and regulations of the State of New York, without reference to
choice of law principles. The terms of this Agreement as it relates to purchases of the
Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use
of the SOFTWARE is subject to the United States, Canada and other applicable copyright
and trademark laws and nothing in this Agreement constitutes a waiver of the rights of
Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in
any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY
ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND
CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER
HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS
SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.



Manual Organization, How to Read the Manual and the Conventions Used

® This manual consists of a chapter for Windows followed by a chapter for Macintosh.

e Windows Macintosh

In this manual, Windows XP Professional/Home Edition is referred to as Windows XP, Windows
Millennium Edition is referred to as Windows Me, Windows 2000 Professional is referred to as
Windows 2000, and Windows 98 Second Edition is referred to as Windows 98 SE.

Where explanations are common to all operating systems, the screens used in the
examples are from Windows XP for Windows and from Mac OS X (10.2) for Macintosh.
This manual describes operating methods for the EOS 20D and uses the EOS 20D screens
in examples. Supplementary information has been given where necessary about functions
that are unique to each camera.

In this document, square brackets [ ] are used to indicate items such as button names and
icon names that appear on the computer screen.

Numbers in parentheses in this document indicate reference pages.

Descriptions of camera operations assume that the reader is familiar with the information in
the camera’s Instruction Manual.

For the restrictions that apply to the software products, refer also to the Readme files for the
respective products.

In order to transfer images from the EOS Viewer Utility, you will need retouching (image
editing) software. In order to start the TWAIN Driver, you will need a TWAIN Driver-
compatible application. Explanations for transferring images from the EOS Viewer Utility
described in these instructions and the explanations for TWAIN Driver-compatible
applications all use examples from Adobe Photoshop 7.0.

The explanations given below describe the type of content indicated by the respective icons.

0 . Marks information that should be read before use to prevent problems that would
interfere with the functioning of software and computer.

@ . Marks additional information that you will find helpful.

Safety Precautions

Please read the safety precautions carefully before using this product. Ensure that you use the
product correctly according to the procedures described in these instructions.

The following safety precautions are intended to instruct you in the safe and correct operation
of the product and its accessories to prevent injuries or damage to yourself, other persons and
property. Please read and ensure that you understand them before you proceed to the other
sections of these instructions.

/\ Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The
extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to
the loud sounds of a data CD-ROM played on a music CD player.
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Software

This section briefly describes the main functions of the software provided on the bundled CD-
ROM.

B EOS DIGITAL Solution Disk
EOS Viewer Utility UL Macintosh)

© Dedicated software for an EOS DIGITAL
camera to be used for downloading and
displaying images, and processing RAW
images.

® Can be used for downloading images
saved on the memory card in the camera
to your computer, displaying single-
frame or thumbnail images, checking
shooting information or histograms.

© Capable of rotating, protecting, and
saving images, printing image indexes,
and transferring images to the
retouching software.

® Can be used for displaying RAW images and specifying various processing parameters.
Supports the color management system.
© Supports the color space of SRGB and Adobe RGB.

EOS Capture EIIETEY Macintosh)

© Enables you to control the camera from your computer to shoot single-frame images or
images using the timer or interval timer. Also, allows you to download images directly to
your computer.

* The EOS Capture is compatible with the EOS 20D only.

* The EOS Capture for Macintosh is only compatible with Mac OS X.

PhotoStitch QT Macintosh)

©® The PhotoStitch creates composite images such as panorama shots by merging multiple
images.

WIA Driver/TWAIN Driver gz

©® The WIA Driver or TWAIN Driver controls the communication between the camera and the
software. You must install the WIA Driver for Windows XP or Me, and install the TWAIN
Driver for Windows 2000 or 98 SE.

® Also used for downloading JPEG images to your computer if you use the WIA Driver alone,
or use the TWAIN Driver with a TWAIN Driver-compatible application.



Software

Operation Flow

Install the software (W-4, M-4) ]
Connect the camera to your computer (W-9, M-9) ]
Start up the EOS Viewer Utility (W-14, M-14) I
To edit/display the images I For remote shooting I
Download the images to your Start up the EOS Capture*?
computer*’ (W-18, M-18) (W-54, M-54)
Edit/Display the images Shoot remotely and download the
(W-22 to 40, M-22 to 40) images (W-56, M-56)

In addition, you can use the WIA Driver or TWAIN Driver (W-63) to quickly and easily
download JPEG images from your camera. You can also use the PhotoStitch to merge
multiple images to create a panorama shot easily.

*1 With the EOS Viewer Utility for Mac OS 9, you cannot download images by connecting the
camera and your computer. Download images to your computer by either using the EOS
Viewer Utility for Mac OS X or by using a third-party card reader.

*2 Remote shooting in the EOS Eapture is only available with the EOS 20D.

You cannot do remote shooting in the EOS Capture on Mac OS 9.

Trademark Acknowledgments
Canon and EOS are trademarks of Canon Inc.
Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.
IBM is a registered trademark of International Business Machines Corporation.
Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation
in the United States and/or other countries.
iBook, iMac and QuickTime are trademarks of Apple Computer Inc.
Macintosh, PowerBook and Power Macintosh are trademarks of Apple Computer Inc.,
registered in the United States and other countries.

® Other names and products not mentioned above may be registered trademarks or
trademarks of their respective companies.




Windows

Where explanations are common to all operating systems, the screens used in the examples
are from Windows XP.

Explains how to set up communication mode, how to connect the camera or a card reader
(third-party product) to your computer and complete the installation.

Explains how to use the EOS Viewer Utility to download images to your computer, edit
and save images, and transfer the downloaded images to the retouching software.

Describes how to use the EOS Capture for taking shots and specifying the camera
settings remotely from your computer.
© Remote shooting in the EOS Capture is only available with the EOS 20D.

Describes how to download JPEG images using the WIA Drivers for Windows XP or
Windows Me, and the TWAIN Drivers for Windows 2000 or Windows 98 SE.




System Requirements

The software bundled with this product runs on the systems described below.

Windows XP (Home Edition/Professional), Windows Me,

os Windows 2000, Windows 98 SE
PC with one of the above OS preinstalled and a USB port as a
Computer standard feature
* Upgraded machines not supported.
CPU Windows XP: 300 MHz Pentium or better
Windows Me, 2000, 98 SE: 150 MHz Pentium or better
RAM Windows XP: Minimum 256 MB
Windows Me, 2000, 98 SE: Minimum 128 MB
Interface USB 1.1 to 2.0 Hi-Speed*

Hard disk space

EOS Viewer Utility: 100 MB or more
EOS Capture: 300 MB or more
WIA Driver: 25 MB or more

TWAIN Driver: 25 MB or more
PhotoStitch: 40 MB or more

Display

Screen resolution: 1024 by 768 pixels or more
Color quality: Medium (16 bit) or more

Depending on your computer system, this software may not run correctly on Windows 98.
Use the Windows 98 SE operating system or later.
A CD-ROM drive is required for installation.

* Only the EOS 20D is compatible with USB 2.0 Hi-Speed.




Installing the
Software

This chapter describes how to install the bundled software.

If you were unable to successfully install the software using the procedure given in
this manual, see “Troubleshooting” (W-70).

Installing the Software ...
Correct Installation Procedure




Installing the Software

® Check that your computer complies with the system requirements for the software (W-2) as
you follow the installation procedure.

Correct Installation Procedure

Always install the software as described in the procedures below.
Start up your computer (step 1).
Install the software (steps 2 through 9).
Remove the CD (step 10).
Set the communication mode (W-8).
Connect the camera to your computer and complete the installation (W-9).

0 Never connect the camera to your computer before you install the software. The
software will not be installed correctly. You must connect the camera to your computer
after removing the CD.

If you connected the camera to your computer before installing the software, see
“Troubleshooting” (W-73).

Start up your computer.

Exit any programs that are running.

Insert the CD (EOS DIGITAL Solution Disk).

The Installer panel appears.

Click the [Install] button.

The [Preparing to Install] window
appears and after a brief wait, the Canon EOS DIGITAL
[Welcome to the InstallShield Sohixkan Own
Wizard for Solution Disk] window
appears.

0 If the dialog box that prompts you to restart your computer appears, restart your computer.
After the computer restarts, the software installation process restarts automatically.

W-4




Installing the Software

4 Click the [Next] button.

_1(J:£! )5._

6 Check the details of the License Agreement and then click the
[Yes] button.
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Check the software and the folder in which the software will be
installed, and then click the [Next] button.

-» Installation begins. It will be
complete in approximately 2 to 3 i Mo
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Installing the Software = g



Installing the Software

8 Click the [Finish] button.

9 Click the [Exit] button.

1 Remove the CD.

-» Continue by setting up
communication mode and
connecting the camera and
computer in Chapter 2 to complete
installation.

0 If you were unable to successfully install the software using the procedure given in this
manual, see “Troubleshooting” (W-70).



Preparation for
Downloading Images

This chapter explains how to set up communication mode, how to connect
the camera or a card reader (third-party product) to your computer and
complete the installation.

If you were unable to successfully install the software using the procedure given in
this manual, see “Troubleshooting” (W-70).

Setting the Communication Mode............cccereiiiiiiiiincirerrr e W-8
Connecting the Camera to Your Computer.........c.cccoccmiinneneessiensnnsnens wW-9
Connecting the Camera to Your Computer for the First Time............... W-9
Connecting the Camera to Your Computer the Second Time or Later ... W-10
Using Your Card Reader .........ccccviiirnmiininnen e ssssssne s W-11

Downloading JPEG Images Using the PTP Function in Windows XP .... W-12




Setting the Communication Mode

To communicate with the camera using the software on the Solution Disk, set the camera’s
communication mode to [Normal].
The settings on this page are only necessary for the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.
With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on
changing, see the Canon website.

Check that the camera is not connected to the computer and then
set the camera’s power switch to <ON>.

Set the camera’s communication mode to [Normal].

Set [Communication] in menu to

[Normal]. —

With the EOS DIGITAL REBEL/ Date/Time
300D DIGITAL, set File numbering
[Communication] in menu option haggiageste
<$T12> to [Normal]. s

Press the <MENU> button to switch the LCD monitor display off
and then set the camera’s power switch to <OFF>.

0 If you set the communication mode to [PTP], the Solution Disk software cannot
communicate with the camera. When you are using the software, always set the
communication mode to [Normal].

When setting the communication mode, always ensure that the camera is not
connected to the computer beforehand. Setting the communication mode while the
camera is connected to the computer will cause camera and software malfunctions.

About the PTP Setting

The PTP function is only available to Windows XP users. This function provides a simple
means of downloading JPEG images to your computer. To use this function, set
[Communication] to [PTP] in step 2 above.
For more information on using the PTP function to download JPEG images, see
“Downloading JPEG Images Using the PTP Function in Windows XP” (W-12).



Connecting the Camera to Your Computer

Before downloading images to your computer or specifying the camera settings, you must
connect the camera to your computer with the dedicated USB cable.
You can connect the camera while your computer is running.

Connecting the Camera to Your Computer
for the First Time

When you connect the camera to your computer for the first time to complete the installation,
follow the procedure below right after performing “Installing the Software” (W-4) and “Setting
the Communication Mode” (W-8).

Plug the dedicated cable into the computer.

Plug the cable into the USB port.
Refer to the computer User’s
Manual for information on the
terminal areas.

Plug the dedicated cable into your camera.

Open the cover and connect the
cable to the < DIGITAL> terminal
with the [*<> ] icon facing the front
of the camera.

With the EOS D60 and EOS D30,
connect by aligning the <p> mark
on the plug with the <> mark on
the < DIGITAL > terminal.

Preparation for Downloading Images H

Set the camera’s power switch to <ON>.

Ny
ﬁ] i) Found New Hardware
L v i\ r — | Canon Digital Camera

When the pop-up menu appears and then disappears automatically, the installation is
complete.

W-9



Connecting the Camera to Your Computer

For Windows 2000, Me, 98 SE, a dialog box such as [Found New Hardware] or
[Building driver information database] may appear. If this is the case, installation will
be completed when the dialog box disappears.

When the installation is complete, the camera is ready to communicate with your
computer. Proceed to Chapter 3 continuously.

0 Do not set the camera’s power switch to <OFF> until the pop-up menu and dialog
boxes automatically disappear.
If the dialog box that prompts you to restart your computer appears, restart your
computer without fail.
If you were unable to successfully install the software using the procedure given in
this manual, see “Troubleshooting” (W-70).

I?—ﬁ_l The pop-up menu and dialog boxes shown in step 3 do not appear when you connect the
camera to your computer the second time or later.

Connecting the Camera to Your Computer
the Second Time or Later

When you connect the camera to your computer the second time or later, follow the same
procedure, set the camera’s power switch to <ON>, and then proceed to Chapter 3.

0 Never perform the following operations while the software installed from the Solution Disk is

running after connecting the camera to the computer as a communications error may occur.

» Set the camera’s power switch to <OFF>.

» Open the CF card slot cover.

« Disconnect the dedicated cable, remove the battery, and then remove the AC
adapter kit (optional) or DC coupler.

« Disconnect the AC adapter’s or DC coupler’s plug or power cord.

Before you perform the operations above, be sure to exit all the software.

You cannot communicate with the camera when you are displaying images through

the camera’s LCD monitor. Always connect the camera and your computer after

turning off the display in the LCD monitor.

While the camera and your computer are communicating, the camera’s LCD panel

may blink.

Use only the dedicated cable.

Push the plug firmly all the way into the socket. Loose connections can cause faults

or malfunctions.

Do not connect the camera to your computer via a hub. If you do so, the camera may

not operate correctly.

If you connect multiple USB devices (excluding mouse and keyboard) to your

computer the camera may not operate correctly. Disconnect other USB devices from

your computer and connect only the camera.

Operation of the Auto power off function will automatically switch the camera off,

disabling to communicate with your computer. Set the Auto power off function to

[OFF] in advance. (Refer to “Menu Operations” in the camera’s Instruction Manual.)



Connecting the Camera to Your Computer

0 ® Do not connect more than one camera to the same computer. The connections may
not operate correctly.
When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull
it out.
* If you are using the EOS D60 or EOS D30, pull the plug while pressing the PUSH

button on it.

If you do not perform any operation while the camera and computer are connected, a
confirmation message appears on the computer screen asking whether you wish to
continue communicating with the camera for some computer systems. If you do not
perform any operation even after this message appears, the communication with the
camera is terminated. To re-establish the communication, press the shutter button
down halfway or set the camera’s power switch to <OFF> and then back to <ON>.
Do not put your computer to sleep while it is connected to the camera.
If your computer goes into the sleep mode, never disconnect the dedicated cable
while your computer is still in the sleep mode. Always wake your computer up while it
is connected to the camera. On some types of computer, disconnecting the dedicated
cable while your computer is in sleep mode could prevent the computer from waking
up correctly. Refer to the computer User’'s Manual for more information on sleep
mode.

I?—ﬁ_l When you connect the camera and your computer, it is recommended that you use an
AC adapter kit (optional) with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D
DIGITAL, and the DC coupler supplied with the EOS D60 and EOS D30.

Using Your Card Reader =

Users with a third-party card reader can download images directly from a memory card to the
computer.

«* Remove the memory card from the camera.
|

Load the card into the card reader.

® Proceed to Chapter 3
continuously.

F—ﬁ_l For information on connecting the card reader to your computer, refer to the card reader
User’s Manual.

W-11
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Downloading JPEG Images Using the PTP Function in Windows XP

Windows XP users can use the PTP (Picture Transfer Protocol) function. The PTP function
allows you to download JPEG images saved on a memory card in the camera to your computer
without having to start the software provided on the Solution Disk.

This function is available with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D

DIGITAL only.

With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on

changing, see the Canon website.

Set the camera’s communication mode to [PTP] (w-8).

Set [Communication] in menu to
[PTP].

With the EOS DIGITAL REBEL/
300D DIGITAL, set
[Communication] in menu option
<¥T2> to [PTP].

Press the <MENU> button to
clear the LCD monitor display.
When you have finished, set the

camera’s power switch to <OFF>.

Date/Time
File numbering
Language

Video system
Communication  Normal
Format

(Custom Fun

Connect the camera to the computer and set the camera’s power

switch to <ON> (w-9).
The [Scanner and Camera
Wizard] dialog box appears.

) 2 i o
——r—s

B - 2R

.—_.

Download images as directed in the [Scanner and Camera Wizard]

dialog box.

For the procedure for downloading JPEG images using the [Scanner and Camera
Wizard], refer to step 3 onwards in “Downloading with [Scanner and Camera Wizard]”

(W-64),

0 Refer to the separate “Notes on the PTP Function” for details when the downloaded
image does not display correctly or the image cannot be downloaded.



Working with Images in
the EOS Viewer Utility

This chapter explains how to use the EOS Viewer Utility to download images
to your computer, edit and save images, and transfer the downloaded

images to the retouching software.

For more information on the restrictions of the EOS Viewer Utility, refer also to the

source listed below.

Readme: Click the [Start] button P> select [All Programs] ([Programs] in other
versions of Windows) B [Canon Utilities] » [EOSViewerUtility xx] (“xx” is
the version) B [EOSViewerUtility Readme].

Starting the EOS Viewer Utility ... W-14

Downloading Images ................... W-18
Handling the Folders.................... W-20
Memory Card Folder Structure and File
Names .......cccocoiiiiiiiciie e, W-20

Registering Frequent Use Folder...W-21

Selecting the Image Display Mode ....W-22
Main Window (Thumbnail Display) ....W-22

Preview Window Display ............ W-22
Selecting the Display Size........... W-24
Checking the AF Point................ W-24
Selecting Images.........cccocevierieen W-25

Selecting Images in the Main Window .. W-25
Selecting Images in the Preview

Attaching Check Marks to Images .....W-26
Selecting Images by Condition... W-26
Bringing/Sending the Main Window to
the Front/Back of Window Stack...W-27
Equalizing the Display Sizes in the
Preview Window ........................
Editing Images.......cccccovreriernnnnnn.
Protecting Images... .
Rotating Images .........cccccevueene

Deleting Images .........ccccccuveennee W-29
Checking the Image Information and
Entering Comments.................... W-29
Printing Images ...........cccocceniunnns W-30
Editing Raw Images .........cccceu... W-31
Processing RAW Images ........... W-31

Specifying the Processing Parameters..W-32
Adjusting the Brightness (Digital

Exposure Compensation)........... W-33
Adjusting the White Balance ...... W-34
Selecting the Contrast................ W-37
Adjusting the Color..................... W-38
Specifying the Color Space........ W-40
Selecting the Sharpness ............ W-40
Saving Images.........cccveeiriinnennnnns W-41
Extracting JPEG Images from RAW
IMages.....cocooiiiiniiiiecec e W-43
Transferring Images to Retouching
Software ......ccccceiresenncceeeeceeees W-44
Specifying the Preferences......... W-46

Setting the IPTC Information....... w-47
Specifying the Camera Settings ...W-50
Merging Images with the PhotoStitch ...W-52




Starting the EOS Viewer Utility

Connect the camera to your computer (w-9).

The dialog box.on .WhICh the
camera model is displayed P
appears.

Your camera model is displayed in
EOS XXX.

For Windows Me, the [Scanner
and Camera Wizard] dialog box
appears.

Click the [Cancel] button to close
the open window. I_-E(- —

b Liss By g A B oo

Click the [Start] button P> select [All Programs] ([Programs] in
other versions of Windows) » [Canon Utilities] »
[EOSViewerUtility xx] » [EOSViewerUtility].

The main window appears.

You can also start the EOS Viewer Utility by double-clicking the [EOSViewerUtility]
icon on the desktop.

The EOS Viewer Utility version information is displayed in xx.



Starting the EOS Viewer Utility

Main window

Main window tool bar Menu bar
Displays the [File], [Edit], [View],
[Option], [Window], [Help] menus.
Image information display area
Path display Displays basic shot information.
Displays the folder path selected Histogram
in the Folder Tree Area. Shows the distribution of the brightness of an

image. Selecting the tab switches the histogram
display values between Brightness and RGB.

] BB g R e
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Status bar Image display area Comment input box (W-29)

Detailed Information

Bookmark area (W-21) display area (W-29)

Folder Tree Area (W-18) RGB value display

When you move the cursor over an image, the
coordinates of the cursor position and its RGB
values (8-bit conversion) are shown here.

® To exit the EOS Viewer Utility, select the [File] menu P> [Exit].

Working with Images in the EOS Viewer Ultility !



Starting the EOS Viewer Utility

Main window tool bar

Folder Tree button
Shows/hides the Folder Tree Area.

Display Size
list box (W-24)

|T|__l| rlr E

Thumbnail Frames button

Shows/hides the information
display frame of thumbnail images.

LA}

Window button (W-27)
Rotate left 90 degrees button (W-28)

Add Check Mark button (W-26)

Show/Hide Image Information button

Shows/hides the histogram, image information display area,
Detailed Information display area, and comment input box.

Rotate right 90 degrees button (W-28)

Remove Check Mark button (W-26)
Remove protect button (W-28)
Erase images button (W-29)
Transfer images button (W-44)

BBy XEN DS & @

EOS Capture
button (W-54)

Save File button
(W-41)

Select images button
(W-26)

IPTC information button

Protect button (W-28) (W-47)

Play sound button

*This button does not work with
the camera you are using.



Starting the EOS Viewer Utility

RAW adjustment tool palette

RAW adjustment g

EOQS XXX—

Digital Exposure Compenzation

Digital Exposure Compensation
slider (W-33)3
Color temperature input box

—

2 o+ +2

(W-35)23
White Balance list box
(W-34, W-35)

White Balance Compensation
slider (W-37)"1-2:3

Standard radio button
(W-38)'1:2.3

Monochrome radio button
(w-38)"2:3

“éhite Balance:

7R I—l_ K A

P aln o

_E)—

G M0 0

Contrast: Stamdard

—+ Standard
Color Saturatior: | Sfamdard
Color Tone: &

— Monochrome

=
L1
4

—

sAGH

Calor Space: I

Stamdard

- —

—

Fieset to Shot Settingsl—

Sharpress:

— Preview

Preview checkbox (W-32)——————

— Displays the name of the camera
on which the selected RAW
images were taken.

— Click White Balance button (W-36)

— Contrast list box (W-37)

— Color Saturation list box (W-38)
_ Color Tone list box (W-38)"3

— Filter Effect list box (W-39) -2 3
— Toning Effect list box (W-39) "1+ 23
_ Color Space list box (W-40)2 3

— Sharpness list box (W-40)

— Reset to Shot Settings button
(W-32)

Update —
| ]

— Update button (W-32)

When you select a RAW image, the name of the camera on which the selected RAW image
was taken and its settable processing parameters are displayed.
"1 Not displayed with the EOS 10D and EOS DIGITAL REBEL/300D DIGITAL RAW images.

2 Not displayed with the EOS
3 Not displayed with the EOS

D60 RAW images.
D30 RAW images.

0 ® Where you have selected a JPEG image or where you have selected a TIFF or JPEG
image converted from a RAW image with the EOS Viewer Utility, nothing is displayed
on the RAW adjustment tool palette and the image cannot be edited.

Where you have selected a RAW image saved on the memory card inside the
camera, nothing is displayed on the RAW adjustment tool palette and the image
cannot be edited. Work with the images saved on your computer from the memory

card.

The settings used when shots were taken are displayed in italic or bold type in the list box.

If the RAW adjustment tool palette is hidden, select the [View] menu P> [Tool palette] to

show it.
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Downloading Images

The procedure below describes how to download (copy) the images saved on a memory card
in the camera to your computer, and display them on the main window. You can download

images in the Folder Tree Area.

Create a folder to which images will be downloaded.

Display a folder to be copied.

From the menu that is displayed
by right-clicking on the destination
folder, select [New folder] to
create a folder and enter a name
for the folder. (The [Photo] folder is
created in the [My Pictures] folder
here as an example.)

Double-click the camera icon
the [1] folder B> the [DCIM] folder.
The [xxxCANON] folder is
displayed. (“xxx” represents a
number 100 to 999.)

T R

[} Deskiop

= D My Documents
+ j [y Music

@ Deskl:ap

- fB My Dacumnents

+ My Music
+-{1=4 My Pictures

-J My Cornputer

Copy the folder to the hard disk.
® Drag and drop the [xxxCANON]

folder to the destination folder.

- The [xxxCANON] folder is saved

on your computer.

|18 Eos
- _‘I 1

=-{2) DCIM

(2 xxGANON,

@ Deskkop
5 Mv Documents

+ _l Iy Music

= _l My Pickures

_,_L My Computer

(=] P hoE xxxO%‘JON



A Click the copied folder.

The images in the folder are
displayed.

Before disconnecting the camera
from your computer, exit the EOS
Viewer Utility, set the camera’s
power switch to <OFF>, and then
disconnect the dedicated cable.

Downloading Images

[ Ecsxy

[Z} Deskiop

=1} My Documents
+ j My Music
= :II My Pictures

+ j My Coriee

0 You cannot display images in the preview window (W-22) or edit RAW images (W-31)
saved on a memory card in the camera directly. Work with the images saved on your

computer from the memory card.

For displaying images saved in a third-party card reader, follow the same procedure
to download the target folder to your computer.

Supported Image Formats

The images below can be displayed with the EOS Viewer Utility.

Image Format

File Extension

RAW images taken with the EOS-1D Mark Il and the EOS 20D .CR2
RAW images taken with the EOS-1Ds and the EOS-1D .TIF
RAW images taken with the EOS 10D, DIGITAL REBEL/300D DIGITAL,

.CRW
D60 and D30
JPEG images conforming with the Exif 2.2, 2.21 standard* JPG/.JPEG
TIFF images conforming with the Exif standard* TIF/.TIFF

* Includes TIFF and JPEG images converted from RAW images and saved with the EOS

Viewer Utility.

0 » Images that cannot be displayed appear as a question mark [?].
The images that are processed on your computer after being shot or the images
whose file name is changed may not be displayed properly.

You cannot use the camera while displaying images on the camera.

I?—ﬁ_l By setting [Auto rotate] setting to <ON> for the camera with this function, images shot
in a vertical position are automatically displayed vertically.
If the selected folder contains a large number of images, there may be a short delay

before the images appear.

Working with Images in the EOS Viewer Utility H



Handling the Folders

You can handle the folder on the menu that appears by right-clicking the folder.

Right-click on the folder and select an option from the menu that
appears.

|2} Deskiop
=) My Documents
+ i‘, Py Music
=112 My Pictures
=1/ Photo

Opens the selected folder.

Ty Ty LOn Cpen

Creates a new folder. Note that you Mew Folder. ..
cannot create a new folder in the
memory card in the camera. Chanlge Folder Name

Allows you to change the folder name.

I?—ﬁ_l You can drag and drop folders from the Folder Tree Area to the other folders.

Memory Card Folder Structure and File Names

—m m IMG_YYYY.JPG: JPEG image
bem | sxcANoN —MG_YYYY.CR2: EOS 20D RAW image
CRW_YYYY.CRW: EOS 10D, EOS DIGITAL REBEL/
300D DIGITAL, EOS D60, EOS
E j D30 RAW images

CRW_YYYY.THM: Image for displaying the camera’s
index
—— The folder that holds the image control files
in the DCIM folder.
CANONMSC

= tl The folder created when DPOF settings are set.
MISC It holds the DPOF settings files.

The “xxx” in the folder names represent a number between 100 to 999.
The “YYYY” in the file names represent a number between 0001 to 9999.

The file name of images shot with the EOS 20D is “_MG_" (the first character is an
underscore) when Adobe RGB is set.
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Handling the Folders

Registering Frequent Use Folder

You can register frequent use folders as bookmark folders.

1 Display a folder to be registered (w-18).

Register a folder as a bookmark folder.

© Drag and drop the folder to be |
registered as shown on the right.

=» The folder icon appears in the Bookmark
Bookmark area when it is
registered. xxGANDN

© To delete the registered folder,
right-click the folder and select
[Delete] from the menu that
appears.

I:Eﬂl © You can also reorder the folders in the Bookmark area by dragging and dropping
them.

© When you delete the registered folder, it just disappears from the Bookmark area.
The actual data of the folder and the images in that folder will not be deleted.

W-21
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Selecting the Image Display Mode =

You can select the display size and method of images.

Main Window (Thumbnail Display)

Various information can be displayed with images.

Display number ——8 1 [.0— Digital exposure

Numbers are assigned compensation value (W-33)

sequentially to the displayed E_ Recording quality

images starting with the first The [RAW] and [RAW+JPEG]

image. symbols are displayed for RAW

and RAW+JPEG images

respectively. No symbol is

displayed for JPEG images.

*Only images taken with the
EOS 20D in RAW+JPEG format

display the [RAW+JPEG]

File name or shooting date/time IMG_0001.CR2 symbol.

The items selected in the [Image

Lower Display Item] list box in the Protect mark (W-28) Check mark (W-26)

E’Fi’stglf:;zr&?es] dialog box (W-46) are This mark is displayed This mark is displayed on images for
on protected images. which a check mark was attached.

Preview Window Display

Double-clicking an image displayed on the main window can enlarge the image.

When you change the processing parameters of RAW images, use this window.

© The preview window can display a maximum of six previews.

© Alow resolution image is displayed first in the preview window, and then it changes to a high
resolution image.

Preview window
RAW adjustment tool palette
]

EOT six

Wl s —

Preview tool bar

o B B T
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Selecting the Image Display Mode

Preview tool bar

Rotate left 90 degrees button (W-28) —
Window button (W-27)

JPEG preview button

Changes the image displayed in the
preview window to a RAW or JPEG
image.

* Only compatible with EOS 20D
RAW+JPEG images and EOS 10D,
EOS DIGITAL REBEL/300D DIGITAL
and EOS D60 RAW images.

Remove Check Mark button (W-26)

Protect button (W-28)

Remove protect button (W-28)

Erase images button (W-29)

Show Next Image button (W-25)

Show Previous
Image button (W-25)

|
|Fit to window e | G B - | & VAR o G - R R

Display Size list box (W-24)

Show/Hide Image Information button
Show/hides the histogram, image information
display area, Detailed Information display area,
and comment input box.

Rotate right 90 degrees button (W-28)

Add Check Mark button (W-26)

Play sound button
*This button does not work with the camera you are using.

Transferimages
button (W-44)

Save File button
(W-41)

AF point button (W-24)
*Only compatible with EOS
20D, EOS 10D and EOS
DIGITAL REBEL/300D

DIGITAL images.

IPTC information button (W-47)

0 You cannot display images in the preview window or edit RAW images (W-31) saved on
a memory card in the camera directly. Work with the images saved on your computer

from the memory card.

® For some images, it may take some time to change to the high resolution image.
@ You can set the image displayed in the preview window to RAW image or the

simultaneously recorded JPEG image (W-46).

W-23
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Selecting the Image Display Mode

]
Selecting the Display Size

Select a display size from the list box.

® In the main window, the available Main window
image sizes are [Small] (64 X 42

pixels), [Medium] (100 X 66 . Canon Digital Camera EQS Yiews
pixels), and [Large] (160 X 106 : - - - -
File(F) EditiE) Wiew(y) Ophion{C) Win

pixels).
Medium - :'—'I ' f

© In the preview window, the
available image sizes are [Fit to
window] and [100%].

©® When you select [100%], you can
change the display position by
dragging the image.

Checking the AF Point

The AF point used when the shot was taken can be displayed.
© This function is only available with images of the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.

1 Display the image in the preview window (w-22).

Click the [AF point] button.

=» The AF point is displayed.
© Clicking the button again hides the  H i {111 T R iRyt a LA DR T T
AF point.
= [

I:Eﬂl When the shot was taken with automatic AF point selection, multiple active AF points
might be displayed.
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Selecting Images

Selecting Images in the Main Window

Click the target image.

=» The frame around the selected
image is colored.

® To select multiple images, hold
down the <Ctrl> key and click the
images.

© To select sequential images, click
the firstimage and then hold down
the <Shift> key and click the last
image.

I:Eﬂl Alternatively, you can use the arrow keys (T «<—{) on the keyboard to select images.

Selecting Images in the Preview Window

Click the target image.

-» The selected image is displayed
on the top window.

Working with Images in the EOS Viewer Ultility H

© When only one preview window is
displayed, you can click the [Show
Previous Image] button or the
[Show Next Image] button to
select the image to be displayed.
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Selecting Images

Attaching Check Marks to Images

You can attach a check mark to the RAW image, allowing you to select images more easily.

Click the [Add Check Mark] button.

When the check mark is placed,
the [w#] icon appears in the frame
of the image.

Clicking the [Remove Check Mark]
button removes the [y#] icon from
the frame of the image, and
erases the check mark.

Help(H}

HonfC  Windowein’
- & %( v )\ fo=]

(2 Window!ah  HeloiH)
- & 3 v(X)=
= St 1

0 You cannot attach the check mark for any images other than RAW images.

F—ﬁ_l When multiple RAW images are selected, the check mark is attached to all the

selected RAW images.

Alternatively, you can perform the same operation using the menu that appears by

right-clicking.

Selecting Images by Condition

This feature allows you to select multiple images in a single operation using conditions.

Click the [Select images] button and select the condition from the

menu that appears.

=» Only images that meet the
condition are selected.

W-26
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Select all

Select all checked images
Select all unchecked images

Select all protected images
Select all unprotected Images

Delete Selection
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Selecting Images

Bringing/Sending the Main Window to the
Front/Back of Window Stack

Select [Move main window to front] or [Move main window to
back] from the menu that appears by clicking the [Window]
button.

=» The main window is brought/sent

to the front/back of window stack. | |- B~ 5B | & % [ov [ e &

TMove main window o Fronk Chel+B
Moy main window to back  Shift+Ckrl+B

Standardize preview window size

Equalizing the Display Sizes in the
Preview Window

You can set all the preview windows to the same size.

1 Select the image whose size is the desired size (w-25).

O eI .

Click [Standardize preview window size] from the menu that
appears by clicking the [Window] button.

=» All the displayed preview windows
are set to the same size as the ] - B v [ e [=

selected image. Miove main window bo Fronk Ctrl+E
Plrnse roin windoos bo back Shifki el

Standardize preview window size

W-27
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Editing Images
You can edit all the images that can be displayed in the EOS Viewer Utility.

I?—ﬁ_l When multiple images are selected, the edits are applied to all the selected images.

Protecting Images

You can protect important images to prevent them from being accidentally deleted.

Click the [Protect] button.

When the image is protected, the
[E=] icon appears in the frame of Wwindow(i)  Help(Hh

the image. fl I% wt Ty E' E F‘!?: J

Clicking the [Remove protect]
button removes the [[]] icon from  [0w{¥#t)  Help(H)
the frame of the image, and clears ﬁ g \,ﬂ E I'I,_. - @

the protection.

F—ﬁ-l The [[ev]] is automatically displayed for images that were protected on the camera.
Protection only prevents images from being deleted. Other types of image operations
can still be performed for protected images.

Alternatively, you can perform the same operation using the menu that appears by
right-clicking.

Rotating Images

You can rotate a selected image by 90-degree increments left or right.

Click the [Rotate right 90 degrees] or [Rotate left 90 degrees]
button.

=» The image rotates 90 degrees in - -
the selected direction. (i) Option(Q) _jiindow(w)  Help(H)

FlEDE ) XN

I?—ﬁ_l By setting [Auto rotate] setting to <ON> for the camera with this function, images shot
in a vertical position are automatically displayed vertically.
If a rotated image is displayed in another application, the image may not appear
rotated.
Alternatively, you can perform the same operation using the menu that appears by
right-clicking.
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Editing Images

Deleting Images

You can move unnecessary images to the Recycle Bin on your computer and delete them.

Click the [Erase images] button.
=» The images are moved to the

Recycle Bin.
RO,
[

g’

Select [Empty Recycle Bin] from the menu that appears by right-
clicking [Recycle Bin] on the desktop.

=» The images are deleted.

0 © Images that you deleted by selecting [Empty Recycle Bin] in step 2 cannot be
restored. Check carefully before deleting images.
© Protect important images (W-28) to prevent them from being accidentally deleted.

Alternatively, you can perform the same operation using the menu that appears by right-

clicking.

Checking the Image Information and Entering Comments

You can check the information recorded with images and input comments.

Detailed Information display area
@ The shooting information is displayed.
The number of items displayed differs depending on the camera settings.
® You can copy the information as text data and paste it into another application.
@ Clicking the [¥] button can hide the Detailed Information display area.

i e 30 4

Comment input box

You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <Enter> key.

0 You cannot insert a hard return in the comment input box.

When multiple images are selected, the information from the image selected last is
displayed.

W-29
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Printing Images

You can use the EOS Viewer Ultility to print images in index format.

Select images to be printed in index format (w-25).

Select the [File] menu » [Print Index].
Printing begins.

ﬁ] If you wish to specify the printer settings, select the [File] menu B> [Page Setup].
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Editing Raw Images

You can specify the processing parameters for RAW images so that the RAW images are
optimized for their intended purpose.

Processing RAW Images

RAW images are processed based on the settings specified on the camera (including the
processing parameters and white balance) and then displayed on the computer.

When the following operations are performed, RAW images are processed and displayed:
* When the preview window is switched from the main window

* When the processing parameters are specified on the preview or main window

* When the image is converted to the TIFF or JPEG format and saved

* When the image is transferred to the specified retouching software

When the images are processed, it takes a while to display them.

Approximate processing times

Operation Details|  gyitching from the main Transferring an image to the
Camera Model window to the preview window | specified retouching software
EOS 20D Approx. 3 sec. Approx. 35 sec.
EOS 10D Approx. 2 sec. Approx. 30 sec.
gg)%%%nLLREBEL/ Approx. 2 sec. Approx. 30 sec.
EOS D60 Approx. 3 sec. Approx. 30 sec.
EOS D30 Approx. 2 sec. Approx. 20 sec.

* The processing times given here are only approximations. Actual processing times
vary widely depending on the images and the computer system.

 Processing times are based on Canon testing standards.

(OS: Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 256 MB)
» The processing time in the retouching software includes starting up time of the retouching
software (when using Adobe Photoshop 7.0).

0 You cannot display images in the preview window (W-22) or edit RAW images saved on
a memory card in the camera directly. Work with the images saved on your computer

from the memory card.

W-31
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Editing Raw Images

Specifying the Processing Parameters

You can specify the processing parameters in the RAW adjustment tool palette.
This processing applies the specified parameters virtually and does not affect the original
RAW images in any way. Consequently, you can redo the processing as often as you like
with different parameters and then reset the modified parameters to the settings used when
the shot was taken.
Linear processing can be specified when an image is saved (W-41) or is transferred to
retouching software (W-44).
The procedure below is an operating method in the preview window, but you can set
processing parameters with the same operation in the main window also. However, in the
main window, you cannot click the [Preview] checkbox and the processing parameters you
have set are immediately reflected in the image.

Display the RAW images in the preview window (w-22).

If the RAW adjustment tool palette is hidden, select the [View] menu P> [Tool palette]
to show it.

Specify the processing parameters (W-33 to W-40).
Clicking the [Reset to Shot Settings] button restores the settings to the values used
when the shot was taken.
If you click the [Preview] checkbox, the specified processing parameters are applied
to the RAW images.

Click the [Update] button.

The RAW images are processed — —
according to the specified Reset to Shot Settings |
processing parameters.

W Eicvicn Ipdate

q. Save (W-41) or transfer images (W-44).

0 The processing parameters set with the EOS Viewer Utility in the RAW images of a
camera other than the EOS 20D are cancelled when you exit the EOS Viewer Utility, and
are reset to the processing parameters for when shooting. Either convert the RAW image
specified with the processing parameters to a TIFF or JPEG image and save (W-41), or
transfer to retouching software (W-44) and save.

I?—ﬁ_l When multiple images are selected in the main window, the specified processing
parameters are applied to all the selected RAW images.
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Editing Raw Images

- 1]
Adjusting the Brightness (Digital Exposure Compensation)

You can adjust the brightness of an image in the range of +/-2 stops in 0.1-stop increments.
© This function is only available with RAW images of the EOS 20D, EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and EOS D60.

Drag the slider left or right to adjust the brightness.

=» The adjusted value is specified in
the RAW adjustment tool palette.

Diigital Expozure Compenszation

[
4

Adjustment value set with the slider.

Working with Images in the EOS Viewer Ultility H
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Editing Raw Images

Adjusting the White Balance

You can adjust the white balance in the images.

Selecting the White Balance

You can select the white balance that is the closest to the light source when shots were taken.

Select the white balance from the list box.

[Shade] and [Color temperature] : _
are not displayed for the EOS D60 White Balance:

and EOS D30 RAW images. \Auto | ﬁ

D aylight |u_ 0

Shade

Clowidy 0o
Tungsten
Fluorezcent

Flazh =
Color temperature
e ATdradig

White Balance Details clc(’l(oKre-ll-:m;) ’

Auto Automatically adjusts the white balance. Approx. 3000 to 7000
Daylight For sunny daylight outdoors. Approx. 5200
Shade For shaded areas outdoors. Approx. 7000
Cloudy For cloudy or hazy days and during sunset. Approx. 6000
Tungsten For tungsten (light bulb) light. Approx. 3200
Fluorescent For white fluorescent light. Approx. 4000
Flash When flash is used. Approx. 6000

Color temperature zggocfon 1"8383?%:?%%?5;2?£:;?$r(?Nf_o:;S)_ Approx. 2800 to 10000

*

Approximately 5500 with the EOS D30 RAW images.

The selected white balance is specified in the RAW adjustment tool palette.
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DIGITAL REBEL/300D DIGITAL.

Editing Raw Images

Specifying the Color Temperature
You can specify the color temperature to adjust the white balance.
© This function is only available with RAW images of the EOS 20D, EOS 10D and EOS

1 Select [Color temperature] from the list box.

Enter a color temperature.

© Enter the color temperature in the
[Color temperature] input box in
the range of 2800K to 10000K (in
100K increments).

=» The entered color temperature is
specified in the RAW adjustment
tool palette.

White Balance:

|A wlo ﬂ

Va

1A eafr
Craylight
Shade
Clauidy
Tungsten

Fluorezcent
o

1]

0

o)A

Wwhhite B alance:

Color temperatur;'lm K£|

1]

0
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Editing Raw Images

Click White Balance Function

Makes white the standard for the part you have selected and automatically adjusts the white
balance.

Click the [Click White Balance] button.

=» When you move the cursor over -
the image, the cursor [[;] changes White B alance:

to [ X]. e ]| 5200

2 Click the part where white is to be the standard.

- D nts and SeTHinge\ITE Nty Decumsnis Wy Picienesi AN IGO0 CR2

X250 Vi L2 Ri209 Gl Ea0d

=» The white balance is adjusted so that the point clicked appears white.

I:Eﬂl © When you use Click White Balance Function, even though you do not click the
[Preview] checkbox, the adjusted white balance is applied to the images.
© When you use Click White Balance Function, [Click WB] is displayed in the [White
Balance] list box.
© You can adjust by selecting the neutral gray parts of the image.
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Editing Raw Images

Correcting the White Balance

You can correct the standard color temperature of the white balance. By using this function, you
can obtain the effectiveness similar to the color temperature converting filter or color
compensating filter (third-party product). The range of compensation is 9 levels for each color.
This function is especially useful for users who understand the role and effect of the color
temperature converting filter or color compensating filter.

This function is only available with the EOS 20D RAW images.

Drag the slider left and right to adjust the white balance.

The corrected value specified using the slider.

B J A |E
G - 1 |E

Dragging the slider toward B-side adds
blue hue, and toward A-side, amber hue.

Dragging the slider toward G-side adds

green hue, and toward M-side, magenta hue. Correction value when shooting.

The corrected value is specified in the RAW adjustment tool palette.

I?—ﬁ_l One level of blue/amber hue is equal to five mireds of the color temperature converting
filter. (Mired: the unit of the density of the color temperature converting filter)

Selecting the Contrast

You can adjust the contrast of an image.

Select a setting from the list box.

» The selected setting is specified in
the RAW adjustment tool palette. Contrast: |5fandard j
® [Mid.Low] and [Mid.High] are not |
displayed for the EOS D60 and i Standard  |hid. Low
EOS D30 RAW images. Color Satura Sanrd'
hid.High
Color Taone: High

W-37
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Editing Raw Images

Color Adjustment

Select the color adjustment options with the radio buttons to make each type of adjustment.
Selecting of color adjustment options is only available with EOS 20D RAW images.

Select the [Standard] radio button or the [Monochrome] radio button.

With the radio button you have % Chandard
selected, you can make the

following color adjustments. Also, Color Saturation: | Sfandard -
!f you se!ect [Monochrome], the Cller Tarme m
image will become monochrome.

[Standard]: Color Saturation, Color {" Manactrame

Tone | J
[Monochrome]: Filter Effect, } l—_|
Toning Effect £

See the section below for
adjustment methods.

Selecting the Color Saturation

Select a setting from the list box.

The selected setting is specified in
the RAW adjustment tool palette. Color Saturation: | $fandard ~
[Mid.Low] and [Mid.High] are not Calar Tane: Lo
displayed for the EOS D60 and hdid. Lo
EOS D30 RAW images. £ Monochrome
i kid. High
~ High

Adjusting the Color Tone

This function is only available with RAW images of the EOS 20D, EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and EOS D60.

Select a setting from the list box.

The selected setting is specified in
the RAW adjustment tool palette. Colar Tare: g hd
The more negative the value, the " Monochrome -2
redder the image becomes, and -1
the more positive the value, the g |
more yellow. +1

® [-2] and [+2] are not displayed for +2

the EOS D60 RAW images.
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Editing Raw Images

Filter Effect

© This function is only available with EOS 20D RAW images.

Select a setting from the list box.

=» The selected setting is specified in
the RAW adjustment tool palette.

Toning Effect

Filter E ffect:

Toning Effect;

I MN-Nonme - I

el

Color Space:

COr:0renge
[+A6lR.Fed

oo o=

© This function is only available with EOS 20D RAW images.

G:Green

Select a setting from the list box.

-» The selected setting is specified in
the RAW adjustment tool palette.

Toning E flect;

I M-None - I

Color Space;

Ian]S:Sepia
B:Blue

Sharpnessz:

F:Purple
I 5f
MG:Green
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Editing Raw Images

Specifying the Color Space

You can set the color space of the images you have taken.
This function is only available with RAW images of the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.

Select a setting from the list box.

The selected setting is specified in
the RAW adjustment tool palette. Calar Space: |:HGB j

Sharpness: Ednhe RGE

I?—ﬁ_l The specified color space is recorded in the ICC profile attached to a TIFF image
converted and saved from a RAW image (W-41).
An ICC profile contains color information, such as color properties and color spaces
of devices which are authorized by International Color Consortium (ICC). With this
ICC profile, many color management systems can minimize the color differences
between devices.

Selecting the Sharpness

You can adjust the edge sharpness of an image.

Select a setting from the list box.

@ Higher values give higher levels of p— o

edge sharpening. Sharphess: | Srandand j
® [Mid.Low] and [Mid.High] are not _ail [

displayed for the EOS D60 RAW Lo

e oes- i Lows
© [Off], [Mid.Low] and [Mid.High] are v

not displayed for the EOS D30 id. High

RAW images. High B

The selected setting is specified in
the RAW adjustment tool palette.

W-40



Saving Images

You can convert and save RAW images to TIFF or JPEG images, and save JPEG images as
another name. When you convert RAW images to the TIFF format and save them, the specified
color space data (W-40) is attached to each of images as the ICC profile automatically.

Select images to be saved (w-25).

Click the [Save File] button and select [Convert and save in file]
from the menu that appears.

The [Save File] dialog box
appears.

B - @B

Specify the settings and click the [OK] button.

The images are saved in the

selected folder. Siim e -

Sarer ik
" Eaven Dignalinsgs ke
7 e o Vol snioce] Pk

Clutgad tuitinge
[#5n -
T g deh

= ;. planly finch
Ll [ e B |II'|-:J|IIT

Dty 2 =]

(@

™ JPEG mmagres m b FLAW I PE G o i iy sebctec]

T i v
+ Dot Mediy
F J Sacpmrin Sl
- Murbas Dight  runbadrg o
7 | |
Tuprple

I Ao S uscic Fils I—Ex Dvi.-.q
|

Restores the settings to their
original ones and closes the
[Save File] dialog box.

|
Applies the settings
and saves the image.

F—ﬁ_l When you convert RAW images to the TIFF images and save them, the ICC profile is
attached to each of images automatically. An ICC profile contains color information,
such as color properties and color spaces of devices which are authorized by
International Color Consortium (ICC). With this ICC profile, many color management
systems can minimize the color differences between devices.

® Alternatively, you can perform the same operation using the menu that appears by
right-clicking.
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Saving Images

The image is saved as a new image in the same folder as the selected image.

Save folder

Allows you to specify the folder in =—————" savain fallowing spexified folder.
which the image will be saved.

When the [Save in following specified folder] radio button has been
selected, this button allows you to specify the folder in which the image
will be saved. The name of the destination folder is displayed next to
the [Browse] button.

Select a setting for [Quality] (compression ratio) when you have selected
[JPEG] from the list box, from [4 (Highest image quality)] through [1
(High Compression Ratio)]. Higher values give higher quality of the

JPEG image.
[ AN
uality [2 -
* ghitsch )
CHBR /o Resﬂlutmnl 95 EIE?IZSU;UECP‘
= it eh Linear
! l; JPEG images in the RAWw+PEG faimat are also selec|2d.
Click this checkbox to also save JPEG Specify the resolution for
images taken in RAW+JPEG format. saving images in a range
* This function is only available with of 10 to 2000 pixels/inch.
EOS 20D RAW+JPEG images.

If some of the images to be saved are RAW images, select [Do not convert], [JPEG], or [TIFF] for
the conversion format. If you select [TIFF], you can select the number of bits used when you save
images from [8bit/ch], [16bit/ch] or [16bit/ch linear]. If you select [JPEG], the images are saved in
the [8bit/ch] format.

The extensions used for the saved files are shown below.

Conversion Format Extension
EOS 20D .CR2
Donotconvert | Fos 10D, EOS DIGITAL REBEL/300D CRW
DIGITAL, EOS D60, EOS D30
JPEG (8bit/ch) JPG
TIFF (8bit/ch) TIF
TIFF (16bit/ch, 16bit/ch linear) TIF
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Saving Images

Click this checkbox when you want to save the image without changing the name.

File Mame:

ey 23101 CoOniversion type name Sequence Start

Murnber Digits numbering at

N

Text
IMG_

Enter the number of digits in the sequential
number that attaches to the file and the
starting number used. A maximum of 9
digits can be specified.

Example IMG_0001_RJ

[ fleo Save Audio File Cancel

This is text inserted before the file number. You can enter up to 12 characters.
When you enter text, an example appears in the [Example] field below the text box.

* This button does not work with the camera you are using.

Click this checkbox when saving the file after converting a RAW image to a
JPEG image or TIFF image adds one of the following at the end of the file name.

Conversion Format Conversion Format Name
JPEG RJ
TIFF (8bit/ch) RT8
TIFF (16bit/ch, 16bit/ch linear) RT16, RT16L

Extracting JPEG Images from RAW Images

A JPEG image simultaneously recorded with a RAW image can be extracted and saved.
This function is only available with RAW images of the EOS 10D and EOS DIGITAL
REBEL/300D DIGITAL and EOS D60.

The EOS DIGITAL REBEL/300D DIGITAL and EOS D60 simultaneously record a Middle/
Fine JPEG image and the EOS 10D simultaneously records the JPEG image set up in the
camera.

The contents that can be set are the same as [Save folder] and [File Name] of “Saving
Images” (W-41).

4 Select the RAW image from which a JPEG image is to be
extracted. (w-25)

% Click the [Save File] button and select [Extract Save JPEG] from
the menu that appears.

The [Extract & save JPEG] dialog
box appears. - - & ]

Specify the desired settings and click the [OK] button.

The JPEG image is saved in the selected folder.
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Transferring Images to Retouching Software

You can transfer the images displayed in the EOS Viewer Ultility to retouching software.
The descriptions given here use Adobe Photoshop 7.0, as an example.

0

In order to transfer images, you will need retouching software such as Adobe
Photoshop.

Be sure to specify the image transfer settings before transferring images.

Click the [Transfer images] button.

The [Image Transfer] dialog box
appears.

i (a)n @
p
Click the [Browse] button.

The [Open] dialog box appears. .
Image Transfer

= Image Transier Apphcation

(" Save in Onginad lmage folde:

Select the retouching software (Photoshop 7.0) to which the
image will be transferred.

» Select the [C:] drive B> [Program

Files] > [Adobe] > [Photoshop el =T p A
7.0] > [Photoshop]. Then click the | =" it = e
[Open] button. s
=» Photoshop is specified and the j::f:h
dialog box closes. I Praeets
L Respues]
Film parrm Phesiehiop s A
T [ T = b
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Transferring Images to Retouching Software

Select the radio button and then select a folder in which the
images to be transferred will be saved.

The images to be transferred are saved ———+ 5y in Original Image foldsr.
as new images in the same folder. i
Click the [Browse] button and then select ———=" Say= in following specified folder.

a folder in which the images to be

transferred will be saved. [

Specify [Output settings] and [File Name] and then click the [OK]
button.

g e g s
e

M ||'r_ Frogam d ey dade P S .

vy in Cingral e i
¥ e el macied ke
[ e
Cund gy i
[ B e
LA L

T o vy
I B ] i

| [ T T TR ———

P g

= Db il
= m— Lagunce S
= o (gt
= F

A

I
e | :.n-!|

® See “Saving Images” (W-41) for the procedure for specifying [Output settings] and
[File Name].

-» Photoshop starts up and displays the transferred images.

-» The transferred images are saved in the folder that you have selected in step 4.

I:Eﬂl © ltis recommended that you should use the retouching software (third-party product)
that supports 16-bit images for the one to be specified for the transfer image function.
© When you convert RAW images to the TIFF format and transfer them, the specified
color space data (W-40) is attached to each of the images as the ICC profile
automatically.
© Alternatively, you can perform the same operation using the menu that appears by
right-clicking.
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Specifying the Preferences

You can specify the preferences for the EOS Viewer Ultility.

Select the [File] menu »> [Preferences].

The [Preferences] dialog box appears.

Specify the settings and click the [OK] button.
The settings are applied and the [Preferences] dialog box closes.

Allows you to select whether the folder that was open the last time is displayed or the
specified folder is always displayed when the EOS Viewer Utility starts up.

Select the information to be displayed below images from [File Name] and [Shooting Date/Time]

poronce |

Irveager Lowsser Diisplas e

[IFie Heme B

Fiddes by chinplewy ot stashup
% Lt diaplayed fokdes
O Following specified lokder

Prarvissy 45
* [RAW rrage
" JPEG mags

i~ Lumond mondnd piodle
sAGD Color Space Profle.iom

el 0K Lwwel —— Restores the settings to their
- | — | — _ original ones and closes the
| [Preferences] dialog box.
Restores the settings  Applies the settings and closes
to the default settings. the [Preferences] dialog box.

Displays the monitor profile set in the operating system.
Settings are made in the operating system.

Select whether the image displayed in the preview window is the RAW

image or the simultaneously recorded JPEG image.

* Only compatible with EOS 20D RAW+JPEG images and EOS 10D,
EOS DIGITAL REBEL/300D DIGITAL and EOS D60 RAW images.

I?—ﬁ_l You can also select in the preview window whether the image displayed is the RAW
image or the simultaneously recorded JPEG image (W-22).
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Setting the IPTC Information

IPTC stands for International Press Telecommunications Council and refers to a standard for
communications and information exchange tags attached to images. The standard was
established by newspaper and communications companies to allow problem-free transmission
of images.

You can attach this IPTC information to JPEG images, or to TIFF and JPEG images that were
converted from RAW images and saved with the EOS Viewer Utility. You can also save the
IPTC information on your computer, and then load the saved information and apply it to other
images.

Select a JPEG or a TIFF image (w-25).

Click the [IPTC information] button.
The [IPTC information] dialog box

appears. Help(t)
XN ..*’a B

Enter information (w-48, w-49).

Select any of [IPTC-1], [IPTC-2], or [IPTC-3] tab to display the tab sheet, and enter
the information.

The entered IPTC information can be saved on the dialog box that appears by
clicking the [Save As] button.

The saved IPTC information can be loaded on the dialog box that appears by clicking
the [Read] button.

Click the [Save] button.

=» The specified IPTC information is applied to the image.

=" Click the [OK] button.
o The [IPTC information] dialog box closes.

I?—ﬁ_l IPTC information settings data saved on your computer is compatible with the EOS
Viewer Utility for both Windows and Macintosh.
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Setting the IPTC Information

IPTC-1 tab
IPTC-2tab IPTC-3 tab
vt = 1]
P — _ll..

Loads the IPTC information saved on your computer.

Saves the entered IPTC information on your computer.

"

Cancels the entered IPTC information.

Displays the image for which you will enter
the IPTC information.

When multiple images are selected, this
button displays the IPTC information for the
previous image.

When multiple images are selected, this
button displays the IPTC information for the
next image.

Displays the image No. in a sequence.

Displays the IPTC information entered before the
[Previous] or [Next] button was clicked.

Applies the entered IPTC information to the image.

Closes the [IPTC information] dialog box.

Settings on the [IPTC-1] tab sheet

You can enter up to 64 characters.
You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 2000 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Setting the IPTC Information

Settings on the [IPTC-2] tab sheet

You can enter up to 10 characters.

Select [Highest Priority (=1)], [Normal (=5)], or
[Low Priority (=8)] from the list box.

R

You can enter up to 256 characters.

You can enter up to 8 characters.

You can enter up to 11 characters.

L S e e
S Jomss

.
N —

You can enter up to 32 characters.

Settings on the [IPTC-3] tab sheet

You can enter up to 3 characters.
You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 256 characters.

You can enter up to 32 characters.

e PR "

—— o e
=
-t |
e [ -
e —

— e
A . e

B —

You can enter up to 32 characters.
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Specifying the Camera Settings

You can specify the owner’s name and data/time in the camera.

Connect the camera to your computer (w-9).

The dialog box on which the camera
model is displayed appears.

Your camera model is displayed in
EOS XXX.

For Windows Me, the [Scanner and

Camera Wizard] dialog box appears.

Click the [Cancel] button to close
the open window.

7%

LS KK

Durvac Corramciond

Gt Bt peoram ko sl o thin acher

[ e s iy paaram o B ncions

o (=)

=~

Start up the EOS Viewer Utility (w-14).

Select the [Options] menu P [Camera Settings].
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4 Specify the settings.

Specifying the Camera Settings

This box shows the camera model, body ID (serial number)
and firmware version.

Enter a value or click the
[A)[ V] buttons to specify

Desra's Hawras

the date and time.

| Date ot T
— @ S Ee e w2

= Frism PL e
The battery level of the——— B 51 -
camera is indicated by ~
[ fmmw] Jor [ ] . Mpmors cand F
When you are using the L |
AC Adapter Kit (optional) .
) ‘gt Irataled
or DC Coupler, [ H lis Fres 573 HE
displayed. L T MB
L Cancel i

Enter the name of a
camera owner. You can
— enter up to 31 characters.

— Imports the date and time
from your computer.

— This box shows whether a
memory card is loaded in
the camera along with the
available space on the
card and its total capacity.
You can also initialize the
memory card by clicking

the [Format] button.

Applies the settings that you have
specified to the camera and closes
the [Camera Settings] dialog box.

|
Restores the parameters to their

original ones and closes the
[Camera Settings] dialog box.

® With the EOS D30, the [Parameters] button is displayed. For details on [Parameters],
refer to the Software Instruction Manual supplied with your camera.

Click the [OK] button.

-» The settings are applied and the [Camera Settings] dialog box closes.

0 Formatting a memory card deletes all the data on the card. Because formatting also
deletes protected images, you should check the data recorded on the card carefully

before proceeding.
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Merging Images with the PhotoStitch ==

You can merge multiple JPEG images to create a panorama shot.

Click the [Start] button »> select [All Programs] ([Programs] in
other versions of Windows) » [Canon Utilities] » [PhotoStitch] >
[PhotoStitch].

-» [PhotoStitch Launcher] appears.

2 Click the [Merge Images] button.

' cad
= PholoStitch Launcher

| Canon
Canon Utilities

=» The PhotoStitch starts up.
© Follow the instructions in the guidance window to merge the images.
© Refer to the PhotoStitch Help menu for more details.

Amond Merge Resulls

Vi e o ey iy, 5 7 it o |l gl e S w5
It [ G o ol i e e el . BT o T

Fon Leeagth ety Bomrw ey P S &5 S

0 @ You cannot merge RAW images in the PhotoStitch.
© Up to four images can be merged using the PhotoStitch.
© You will need QuickTime 3.0 or later to save merge images made using the
PhotoStitch in the QuickTime VR format. If QuickTime 3.0 or later is not already
installed on your computer, obtain and install it separately.
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Remote Shooting in
the EOS Capture

This chapter describes how to use the EOS Capture for taking shots and
specifying the camera settings remotely from your computer.

For more information on the restrictions of the EOS Capture, refer also to the source

listed below.

Readme: Click the [Start] button P select [All Programs] ([Programs] in other
versions of Windows) P> [Canon Utilities] » [EOS Capture xx] (“xx” is the
version) P [EOS Capture Readme].

©® Remote shooting in the EOS Capture is only available with the EOS 20D.

Starting the EOS Capture..........ccocvruennnes . - W-54
Remote Shooting .......ccccuviuimiirici i e W-56
Single-frame ShOOtiNG .........ooiiiiiiiiiie e W-56
TimMeEr SNOOING ...eeeeiiee it e W-57
Interval Timer ShOOtING ......cuvviiiiiieiiie e W-58
Specifying the Camera Settings..........ccocerieieisinnsininecnne e W-59
Camera SEtNGS ...ccoiuuiiiiiii it W-59

White Balance Adjustment ..........coooeiiiiiiiiiie s W-61
Specifying the Save Destination...............ccoveeiieiiiiiiiiicie e W-62




Starting the EOS Capture

©® Remote shooting in the EOS Capture is only available with the EOS 20D.

W-54

Connect the camera to your computer (w-9).

The dialog box on which the
camera model is displayed
appears.

Your camera model is displayed in
EOS XXX.

For Windows Me, the [Scanner
and Camera Wizard] dialog box
appears.

Click the [Cancel] button to close
the open window.

Diesden Corneched

Sedect e progeam bo kaunch o e achon

|:| Piberays use Lkes progam o thes aclon

v

Cancel

Start up the EOS Viewer Utility (w-14).

Select the folder to save the image in.

Select a folder in the Folder Tree
Area to save the image in, or
create a new folder (W-18). (The
[Capture] folder is created in the
[My Pictures] folder here as an
example.)

EQSxRn

@ Deskiop
=1-{5) My Documents
|i|..l'r,j. Plne Pliicie

: | Fnoco
[+ My Computer

Click the [EOS Capture] button.

The EOS Capture main window
appears.

v@v@@@




Starting the EOS Capture

EOS Capture main window

File  Tool

Help

&

Allows you to check and —
specify the camera
settings (W-59).

& button (W-61)

Shows/hides the white
balance adjustment dialog
box.

.

M
S200
)

125 FS.5)
150

oo

RAW '|" L .

J

PO 0O6

[ ONESHoT

@

52t

®

@

- Rotate button

The image is downloaded,
rotating 90 degrees each
time you click the button,
regardless of the vertical or
horizontal position of the
camera.
* To use the rotation function,
click [Rotate Image]
checkbox in [Save settings]

dialog box (W-62).

Al B
e N
lnz
. G3
A
i -
M_ i

Release button (W-56)

- Status

Displays the status while
specifying the settings.

5 Click the [Release] button to take a shot (w-56).

® To exit the EOS Capture, select the [File] menu P [Exit].

I:Eﬁl The EOS Capture operates in conjunction with the EOS Viewer Utility. Therefore, when
you exit the EOS Viewer Utility, the EOS Capture also exits.
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Remote Shooting

You can control the camera from your computer and take single-frame shots, timer shots and
interval timer shots. The images are automatically saved on your computer.

Single-frame Shooting

Set the camera up ready to shoot.

Make various settings.

See “Camera Settings” (W-59) and “White Balance Adjustment” (W-61) for
information on how to specify the camera settings.

See “Specifying the Save Destination” (W-62) for information on how to specify the
settings for saving images.

Click the [Release] button.

The shot images are displayed in

the EOS Viewer Utility and saved - b
in your computer automatically. D ﬁ m

0 Before you use the Remote Shooting function, be sure to check that the camera is ready
for shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you
cannot perform the operation as explained.

F—ﬁ_l Alternatively, you can press the space bar to shoot.
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Remote Shooting

Approximate Transfer Time for Shooting RAW Images
| EOS 20D | Approx. 5seconds |

 The transfer time given here is only an approximation. Actual transfer time varies
widely depending on the images and the computer system.

» The time for images shot in JPEG format will be shorter than those shown above.

« Transfer time is based on Canon testing standards.
(Time until images appear in the EOS Viewer Utility main window after you uncheck the
[Save also on the camera’s memory card] checkbox and click the [Release] button in the

EOS Capture main window using the following: OS: Windows XP; CPU: 2.2 GHz Pentium
4; RAM: 256 MB)

0 When the camera is set to One Shot AF, you cannot take shots if the camera cannnot
focus.
If you cannot take shots with the auto focusing, focus manually and then take a shot.
If you take remote shooting while you are using the Explorer in the WIA Driver to
display images on the camera, Remote Shooting function may not operate correctly.

F—ﬁ_l The number of available shots changes depending on the available capacity on your
computer’s hard disk. You can check the number of available shots with the [Shots to
Go] (W-59).

Timer Shooting

Select the [Tool] menu P [Timer shooting].

The [Timer shooting setting] dialog box appears.

“% Enter a delay time and click the [OK] button.

- ® You can set a value between 0
seconds and 99 minutes 59
seconds in 1-second increments.

Ther & luxrtingg satling

Fisg thal Soloevin for peolonigid Shaoting

ey rlse brise et
=» Timer shooting shots are taken. U hreussebckd AC cuthiti for the carmend and P
P e PC'3 Dowlr-Enirg ncton
Diolyy sattirg
Dty time

Iritinrval timie chootng

<-> >$

Sreobrg nberal

hio. of ghots
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Remote Shooting

Interval Timer Shooting

Select the [Tool] menu P [Timer shooting].

=» The [Timer shooting setting] dialog box appears.

2 Click the [Interval timer shooting] checkbox.

erval timer shooting

shooting interval

Mo, of shots

3 Enter the shooting interval and the number of shots. Then click
the [OK] button.
©® You can set a shooting interval

between 5 seconds and 99
minutes 59 seconds in 1-second

ner shosting sctting

K th foderer o prokorgid dhooting
wing inbereal Lirer dhoalirm.

increments. Lo Frusehoid AC outlets for 11 camen and P

® You can set up to a maximum of Ralaass tha BEa povwer-vire] Lrclin
1999 shots. — -

= Interval timer shooting is Dz tima [ oghe
performed using the specified e —
interval between shots and the ™ <footnd -
specified number of shots. SreE el Lo

Mo, of shald T =

(= )=1

0 On some types of computers, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots at
the specified interval. If this occurs, set a longer interval between shots and take the
shots again.
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Specifying the Camera Settings

You can check and change the settings in the camera from your computer remotely.

Camera Settings

You can check and specify the camera settings.

Check the camera settings.

Shutter speed

Displays/specifies Tv (shutter speed).
(Not displayed when Aperture-priority AE or Program AE is specified for the shooting mode)

Color temp.

Specify the color temperature in a range
of 2800K to 10000K.

Aperture value

Displays/specifies Av (aperture value).
(Not displayed when Shutter-priority AE or

Program AE is specified for the shooting mode)

Shooting mode
Displays the shooting
mode.

White Balance
Displays/specifies
the white balance.
Metering mode

Displays/specifies
the settings of the
metering mode.

—M
—S

I .
—(&] m+4L B
‘2. i'-‘l -?i |‘1; ."‘2

125
5200

£5,50

ISO Speed

150 I Displays/specifies the ISO speed.

0o

Image recording quality

| Displays/specifies the image
recording quality.

L Save destination display

Displays the destination folder
to which images will be saved.

(When you click the [Save also

on the camera’s memory card]

checkbox, the camera/PC icon

Exposure compensation

Displays/specifies the exposure
compensation value.

Bracket shots

Displayed when any of WBB/
AEBJ/FEB is specified.

Battery status

When you are using a battery,
[ {mmw] ]is displayed. When
you are using the AC Adapter
Kit (optional) or DC Coupler

Kit, [ § 1is displayed.

*

Drive mode
Displays the drive mode.

C] ONESHOT

— | #

A 33

information needed is displayed.

Warning display

is displayed, and when you
uncheck the checkbox, the PC
icon is displayed.)

AF mode
Displays the AF mode.

Shots to Go

Displays the number of
available shots.

Displayed when the remote shooting is
impossible due to inappropriate settings.

The above window shows all the information at once. In actual use, only the
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Specifying the Camera Settings

Click the icon.

© The icon displayed here shows
exposure compensation as an
example.

(

Use the button to change a value.

Minimum settings button Maximum settings button
Specifies the minimum value. Specifies the maximum value.
OXONOKC
1-step down settings button 1-step up settings button

Allows you to decrease the value by 1 step.  Allows you to increase the value by 1 step.

=» The changed settings are applied to the camera.

0 © Before you specify the settings, be sure to check that the camera is ready for
shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you
cannot make some of the settings.

© Set functions which you cannot set with EOS Capture (drive mode, AF mode etc.) in
the camera.
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White Balance Adjustment

Specifying the Camera Settings

You can compensate white balance with the blue/amber/green/magenta digital filter.

© |If the dialog box has not appeared, click the [§3] button.

Click the compensation position.

Compensate green.

——— Displays the

compensation value.

Compensate amber.

®
G
i AZ
{ G3
=]
Compensate blue. B )\ S’ A |
o
|

Compensate magenta.

-» The changed settings are applied to the camera.
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Specifying the Camera Settings

- 1]
Specifying the Save Destination

You can specify save destination files and file names.

Select the [File] menu P> [Save destination settings].

=» The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Save settings dialog box

Clicking the checkbox also saves images Allows you to change the destination folder to which images
on the memory card in the camera. will be saved. The name of the destination folder is displayed
next to the [Browse] button.

Save sellings

Savn destination

EADecumens ard Sellrgs S Dekl Hrrm.._i

= Gave slpo on the camala's mamony caid

F e pathng

Faeriame fup o 15 chaiscle) Image._ - Use this field to enter a file name when saving

an image. The file name can consist of up to

Filariame ghart rumbes 0000 — —| 18 characters.

Mlatess Image Enter a sequential number with a range of 0000
' o N | 109999 thatis added to the end of the file name.

ok, coca |
|

Cancels all the settings, and restores the settings to their original ones.

Applies the settings and closes the [Save settings] dialog box.

Click the checkbox to enable use of the rotation function (W-55).
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Downloading JPEG
Images with the Driver

This chapter describes how to download JPEG images using the WIA
Drivers for Windows XP or Windows Me, and the TWAIN Drivers for
Windows 2000 or Windows 98 SE.

A number of restrictions apply to the WIA Driver. You must read the “WIA

Driver Readme” file before using the WIA Driver.

Readme: Click the [Start] button P> select [All Programs] ([Programs] in Windows
Me) B [Canon Utilities] » [EOS XXX WIA Driver] » [WIA Driver
Readme].

For more information on the restrictions of the TWAIN Driver, refer also to the

sources listed below.

Readme: Click the [Start] button P select [Programs] P [Canon Utilities] » [EOS
XXX TWAIN Driver] » [TWAIN Driver Readme].

Help: Displayed by clicking the [Help] button in the TWAIN Driver main
window.

Your camera model is displayed in EOS XXX.

Downloading Images with the WIA Driver.........ccccoeeniiieniininnnninnns W-64
Downloading with [Scanner and Camera Wizard] ............c.cccceevveninee. W-64
Downloading with EXPIOrer.........cccccoiieiiiiiii it W-66
Downloading with the WIA TWAIN ........oooiiiiiii e W-67

Downloading Images with the TWAIN Driver........cccoerinnninniniicnnnns W-68




Downloading Images with the WIA Driver

You can download JPEG images using the [Scanner and Camera Wizard] dialog box, Explorer
or WIA TWAIN. Windows XP users can use the same procedure to download JPEG images
using the PTP function (W-12).

See Chapter 3 to download RAW images.

The camera name is shown in the operation screens as “EOS XXX”.

Downloading with [Scanner and Camera Wizard]

You can download JPEG images to your computer by following the instructions on the dialog boxes.

Connect the camera to your computer (w-9).

The dialog box on which the camera model is displayed appears.

For Windows Me, the [Scanner and Camera Wizard] dialog box appears. Proceed to step 3.
Select [Microsoft Scanner and Camera Wizard], and then click the
[OK] button.

The [Scanner and Camera
Wizard] dialog box appears.

Miesdiese Corewscied

Sebec e prosgram bo Reunch lor s aclon

[ ovanss i Ihas wogaam her e sclon

nk: Cancel |

"®» Click the [Next] button.

=» The [Choose Pictures to Copy]
dialog box appears.
For Windows Me, the [Picture
Selection] dialog box appears.

W e ol D M L

Wedooma W B Soarvar and Carars
Wieard

W-64



Downloading Images with the WIA Driver

Select the image(s) you wish to download and click the [Next]
button.

The [Picture Name and

Destination] dialog box appears.
For Windows Me, the [Picture e
Destination] dialog box appears. 1 1

Select the destination folder, enter the file name and click the
[Next] button.

The images are downloaded and the [Other Options] dialog box appears.

If you do not select the destination folder, a new folder is created in [My Pictures] and
images are saved in that folder.

For Windows Me, select the destination folder, enter the file name and click the
[Finish] button. The images are saved and the [Picture Destination] dialog box closes.

Select the [Nothing. I'm finished working with these pictures]
radio button and click the [Next] button.

The [Completing the Scanner and Camera Wizard] dialog box appears.
Click the [Finish] button.

~» The images are saved and the
[Scanner and Camera Wizard]
dialog box closes.

T L

Completing the Scanner and Camen
‘Wizeed
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Downloading Images with the WIA Driver

Downloading with Explorer

You can download JPEG images to your computer by dragging and dropping them.

1 Connect the camera to your computer (w-9).

-» The dialog box on which the camera model is displayed and the [Scanner and
Camera Wizard] dialog box appear.
® Click the [Cancel] button to close all the open windows.

2 Start up Explorer and select a folder.

© You can start Explorer by right-
clicking the [Start] button and
selecting [Explorer] from the menu
that appears.

© In the Explorer view, double-click
the connected camera’s icon and
then click the [xxxCANON] folder
(For Windows Me, double-click the
[xxxCANON] folder). (“xxx”
represents a number 100 to 999.)

©® With the EOS D60 and EOS D30,
click the camera icon.

=» The camera’s images will be
displayed as thumbnails in the
Explorer view.

3 Save the image.

® Drag and drop the image to the
folder in the Explorer view. . -
- The image is saved. (&} Desktop
= Ea Py Diocurments
My Music
= @ My Pickures

Folders

B+

= d My Compuy 58
,_H.mFIImvm A

0 If you attempt to use Remote Shooting while you are using Explorer to display images on
the camera, the Remote Shooting function may not operate correctly.
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Downloading Images with the WIA Driver

Downloading with the WIA TWAIN

You can download JPEG images to your computer by using the TWAIN Driver-compatible
retouching software. The descriptions given here use Adobe Photoshop 7.0, as an example.

Connect the camera to your computer (w-9).

~» The dialog box on which the camera model is displayed and the [Scanner and
Camera Wizard] dialog box appear.
© Click the [Cancel] button to close all the open windows.

Start Photoshop.

® Click the [Start] button P> select [All Programs] ([Programs] in Windows Me) » [Adobe
Photoshop 7.0].
~» Photoshop starts up.

Select the [File] menu »> [Import] » [WIA-EOSXXX].

=» The [Get Pictures from Canon EOS XXX] dialog box appears.

Select the image(s) you wish to download and click the [Get
Pictures] button.

=» The selected image(s) will be
downloaded to Photoshop.

Which plchines o you want o copy?
oo o e e T P R e iyt ey S Yl e
[ Pemye—

B [t | P [ omtitl 3 D’

oy T

[ % | .
= ==

I:Eﬂl The method for starting the application and the dialog box contents differ depending on
your retouching software. Refer to the retouching software User’s Manual for details.

§e
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Downloading Images with the TWAIN Driver®

You can download JPEG images to your computer by using the TWAIN Driver-compatible

retouching software. The descriptions given here use Adobe Photoshop 7.0, as an example.

©® See Chapter 3 to download RAW images.

©® The camera name is shown in the operation screens as “EOS XXX".

© Refer to the Software Instruction Manual supplied with the camera for information about the
TWAIN Driver for the EOS D60 and EOS D30.

Connect the camera to your computer (w-9).

=» The dialog box on which the camera model is displayed appears.
® Click the [Cancel] button to close all the open windows.

Start Photoshop.

® Click the [Start] button P select [Programs] P [Adobe Photoshop 7.0].
=» Photoshop starts up.

Select the [File] menu »> [Import] » [Canon EOSXXX].

=» The TWAIN Driver starts and the e wiin

JPEG image in the camera is ‘e ¥

displayed.
® To exit the TWAIN Driver, select
the [File] menu P> [Exit].

4 Select the image to be transferred and select the [File] menu »
[Transfer Images].

-» The image transferred to Photoshop is displayed.
I:Eﬂl ® You can also transfer images by double-clicking a thumbnail image.
© The method for starting the application and the dialog box contents differ depending

on your retouching software. Refer to the retouching software User’s Manual for
details.
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Troubleshooting and
Uninstallation

This chapter provides troubleshooting and describes the software
uninstallation procedures.

Troubleshooting ..o —————— W-70
Uninstalling the Software...........ccccoviiiiiniiiinn e W-74
Uninstalling the Software ............coeiiiiiiii e W-74
Uninstalling the DFIVEr ......cc..oiiiiiiiii e W-75




Troubleshooting

When the “Could not complete installation correctly” or “Communication between the camera
and computer failed” message appears, check the items described below.
The camera name is shown in the operation screens as “EOS XXX”.

Installation failed.

@ If you are using Windows XP Professional or Windows 2000, are you using
the computer under a user setting other than [Computer administrator] or
[Administrator]?

- You cannot install software if a user setting other than [Computer administrator] or
[Administrator] is selected. Select the [Computer administrator] user setting in Windows
XP Professional or the [Administrator] user setting in Windows 2000. For detailed
information on selecting the user setting, refer to the computer User’s Manual.

@ Is the cable firmly plugged into its socket?
- To complete the installation, ensure that the plugs on the dedicated cable are securely
plugged into the ports on the camera and computer when you connect the camera to
your computer (W-9).

® Are the camera and computer set up correctly for communication?
- |s the camera’s power switch set to <ON>?
- Even when the camera’s power switch is set to <ON>, operation of the Auto power off
function will automatically switch the camera off. To prevent this, set the Auto power off
function to [Off]. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

® Does the [Add New Hardware Wizard] ([Found New Hardware Wizard] in
Windows 2000) dialog box appear during installation?
- Click the [Cancel] button, disconnect the dedicated cable, and then repeat the
installation procedure from the beginning.

® Doesn’t the installer panel appear?

- Use the following procedure to display the installer panel. -
Click the [Start] button B> [My Computer]. (In other versions of |
Windows, double-click [My Computer] on the desktop.) P right- {
click the CD-ROM drive containing the CD P> select [Open] from
the menu that appears P> double-click the icon on the right.
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Troubleshooting

| have installed the software but the camera and
computer cannot communicate.

Is the driver installed?

- The driver is required for communications between the camera and computer. When you
want to communicate between the camera and computer, be sure to install the driver
shown below appropriate to your windows.

* Windows XP/Windows Me: WIA Driver
» Windows 2000/Windows 98 SE: TWAIN Driver

Have you installed the WIA Driver or TWAIN Driver?

- Even if you have installed the WIA Driver or TWAIN Driver, installation is not completed
unless the camera is connected to the computer. Insert the Solution Disk into the CD-
ROM drive, install the WIA Driver or TWAIN Driver, and then connect the camera to your
computer.

Does your computer comply with these requirements?
- PC with Windows XP, Windows 2000, Windows Me or Windows 98 SE preinstalled and
equipped with an a USB port.

* Operation is not guaranteed when a connection is used on computer systems other
than those listed above.

Are the camera and computer connected correctly?
- Connect the camera to your computer correctly using the dedicated cable (W-9).

Is the correct communication mode selected on the camera?

- When using the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D DIGITAL, set the
camera’s communication mode to [Normal]. (W-8) With the EOS 10D, you must also
change the firmware to version 2.0.0 or later. For details on changing, see the Canon
website.

Is there sufficient charge left in the camera battery?

- Your computer does not supply power to the camera. With the EOS 20D, EOS 10D and
EOS DIGITAL REBEL/300D DIGITAL, connect to the camera with an AC Adapter Kit
(optional). With the EOS D60 and EOS D30, Connect to the camera with the DC Coupler
supplied. Or, load a fully charged battery into the camera before connecting it to your
computer.

Do you have more than one camera connected to your computer?

If you connect more than one camera to the same computer, the driver and camera may not

operate normally.

- Exit the software and disconnect all the dedicated cables. Then connect only one
camera to the same computer again.
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Troubleshooting

@ Is the driver operating normally?
Connect the camera to your computer
with the dedicated cable and set the
camera’s power switch to <ON> (W-9)
and open [Device Manager] (W-73). Click
the plus symbol [+] to the left of [Imaging
devices] and check that the connected
camera is displayed.
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- If the connected camera is not displayed, the driver is not operating normally. Briefly
disconnect and then reconnect the dedicated cable, ensuring that the connection is
secure. If the connected camera still does not appear, use the following procedure to re-

install the driver.

1 Disconnect the dedicated cable and delete the driver (W-75).

2 Re-install the driver (W-4).

- When the [X], [!] or [?] symbol is displayed beside the connected camera, part of the
driver is missing or corrupted. Use the following procedure to re-install the driver.
1 Delete the camera displayed in [Imaging devices].
2 Disconnect the dedicated cable and delete the driver (W-75).

2 Re-install the driver (W-4).

@ Is the driver installed correctly?
Connect the camera to your computer with the dedicated cable and set the camera’s power
switch to <ON> (W-9) and open [Device Manager] (W-73). Click the plus symbol [+] to the
left of [Other devices] or [Unknown devices] and check whether the connected camera or
[Canon Digital Camera] is displayed.

e 1)

W-72

= W P




Troubleshooting

- If the connected camera or [Canon Digital Camera] is displayed in [Other devices] or
[Unknown devices], the driver was not installed correctly. Use the following procedure to
re-install the driver.

Delete the camera or [Canon Digital Camera] displayed in [Other devices] or
[Unknown devices].

Disconnect the dedicated cable and delete the driver (W-75).

Re-install the driver (W-4).

I connected the camera to the computer before
installing the software

® Did you set the camera’s power switch to <ON>?

- If you did not set the camera’s power switch to <ON>, proceed as follows:
Disconnect the dedicated cable from the camera and computer.
Install the Solution Disk software on your computer using the correct installation
procedure (W-4) and then connect the camera to your computer to complete the
installation (W-9).

- If you set the camera’s power switch to <ON>, proceed as follows:
If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel]
buttons to cancel all the dialog boxes.
Set the camera’s power switch to <OFF>.
Disconnect the dedicated cable from the camera and computer.
Install the Solution Disk software on your computer using the correct installation
procedure (W-4) and then connect the camera to your computer to complete the
installation (W-9).

To Display the Device Manager
® Windows XP

- Click the [Start] button P> select [Control Panel] B [Performance and Maintenance]
P> [See basic information about your computer]. Then select the [Hardware] tab
and click the [Device Manager] button.

@® Windows 2000

- Click the [Start] button B> select [Settings] B [Control Panel]. Then double-click the
[System] icon to open and select the [Hardware] tab and click the
[Device Manager] button.

® Windows Me and Windows 98 SE
- Click the [Start] button B> select [Settings] B [Control Panel]. Then double-click the
[System] icon to open and select the [Device Manager] tab.
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Uninstalling the Software

Before beginning the uninstallation, exit all programs you are using and disconnect the
dedicated cable from your computer.

Uninstalling the Software

The following uses the procedures for uninstalling the EOS Viewer Utility as an example for
uninstalling other programs as well.
For Windows XP Professional or Windows 2000, log in using computer Administrator
privileges.
Before beginning the uninstallation, exit all programs you are using and disconnect the
dedicated cable from your computer.
To prevent computer malfunctions, always restart your computer after you have uninstalled
the software. Re-installing the software without first restarting your computer is likely to
result in computer malfunctions.

Click the [Start] button »> select [All Programs] ([Programs] in
other versions of Windows) » [Canon Utilities] >
[EOSViewerUtility xx] » [EOSViewerUtility Uninstall].

The EOS Viewer Utility version information is displayed in xx.

Proceed with the uninstallation as directed by the on-screen
messages.

Software is uninstalled.
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Uninstalling the Software

Uninstalling the Driver

This section explains how to uninstall the EOS 20D driver. For cameras other than the EOS

20D, please refer to the Software Instruction Manual supplied with the camera.

® For Windows XP Professional or Windows 2000, log in using computer Administrator
privileges.

© Before beginning the uninstallation, exit all programs you are using and disconnect the
dedicated cable from your computer.

©® The camera name is shown in the operation screens as “EOS XXX”.

1 Uninstall [EOS XXX WIA Driver] or [EOS XXX TWAIN Driver].

©® Your camera model is displayed in EOS XXX.

® For Windows XP or Windows Me, click the [Start] button P select [All Programs]
([Programs] in Windows Me) B [Canon Utilities] » [EOS XXX WIA Driver] » [WIA
Driver Uninstall].

® For Windows 2000 or Windows 98 SE, click the [Start] button B> select [Programs] »
[Canon Utilities] » [EOS XXX TWAIN Driver] » [TWAIN Driver Uninstall].

2 Proceed with the uninstallation as directed by the on-screen
messages.

=» The driver is uninstalled.

3 Restart the computer

©® When the dialog box on the right
appears, select [Yes, | want to
restart my computer now.] radio
button and click [Finish] button.

=» When the computer is restarted,
uninstalling of the driver is
completed.
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Macintosh i

Where explanations are common to all operating systems, the screens used in the examples
are from Mac OS X (10.2). In this chapter, Mac OS X and Mac OS 9.2 are referred to as OS X
and OS 9 respectively.

Explains how to set up communication mode, and how to connect the camera or a card
reader (third-party product) to your computer.

Explains how to use the EOS Viewer Ultility to download images to your computer, edit
and save images, and transfer the downloaded images to the retouching software.

Describes how to use the EOS Capture for taking shots and specifying the camera
settings remotely from your computer.

© Remote shooting in the EOS Capture is only available with the EOS 20D.
© The EOS Capture is only compatible with OS X.




System Requirements

The software bundled with this product runs on the systems described below.

oS Mac OS X 10.1 to 10.3, Mac OS 9.0 to 9.2

Macintosh with one of the above OS installed and a USB port as a
Computer standard feature

* Users of first-generation iMacs require a firmware update.
CPU Power PC

Mac OS X 10.1 to 10.3: Minimum 256 MB

RAM Mac OS 9.0 to 9.2: Minimum 128 MB

Interface USB 1.1 to 2.0 Hi-Speed*

EOS Viewer Utility: 100 MB or more
Hard disk space | EOS Capture: 300 MB or more
PhotoStitch: 30 MB or more

Resolution: 1024 X 768 or more

Displ
Isplay Colors: Thousands or more

The EOS Capture is only compatible with Mac OS X.
Because the EOS Viewer Utility for Mac OS 9 has no function for communication with
the camera, you cannot download images from the camera (M-18) or specify camera
settings (M-50).
These software programs are not compatible with UFS (Unix File System) formatted disks
on Mac OS X.
A CD-ROM drive is required for installation.

* Only the EOS 20D is compatible with USB 2.0 Hi-Speed.



Installing the
Software

This chapter describes how to install the bundled software.

Installing the Software ..o M-4




Installing the Software

® Check that your Macintosh complies with the system requirements for the software (M-2) as
you follow the installation procedure.

Start up your Macintosh.

Quit any programs that are running.

Insert the CD (EOS DIGITAL Solution Disk).

The CD icon appears on the
desktop.

Start installation.

Double-click the CD icon P the oS X
[Mac OS X] folder. Then double- =y
click the icon on the right. u
Canon EOS Digital
Instakler
For OS 9, double-click the [Mac 0S 9

OS 9] folder in the CD window and

then double-click the icon on the
right. Canon EQS Digital Installer

=» The Installer panel appears.

A Click the [Install] button.
s

Canon EOS DIGITAL
Solution Disk

Rugestes




Installing the Software

Select [Easy Installation] and click the [Next] button.
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Check the details of the License Agreement and then click the
[Agree] button.
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Check the folder in which the software will be installed and then
click the [Next] button.

=» Installation begins. It takes i — P i
approximately 2 to 3 minutes. ke o A g e b L e sy S
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Installing the Software

Finish the installation.

© Click the [OK] button.
=» After clicking the [OK] button in o
OS 9, the restart dialog box .

appears. Click [Yes] button to

restart your computer.

Wriliilaresn his At

9 Click the [Exit] button.

b E05S DIGITAL

Solution Disk

Install

U

1 Once the installation is complete, remove the CD.

©® Continue by setting up
communication mode and
connecting the camera and
computer in Chapter 2.




Preparation for
Downloading Images

This chapter explains how to set up communication mode, and how to
connect the camera or a card reader (third-party product) to your computer.

Setting the Communication Mode...........ccccvrriiiririinnnnie e M-8
Connecting the Camera to Your Computer.........ccccevrvmmnniennnsssenssinenns M-9
Using Your Card Reader .........cccceinieiiinnnens s s ssss s M-11

Downloading JPEG Images Using the PTP Function in OS X (10.1 or later).M-12




Setting the Communication Mode

To communicate with the camera using the software on the Solution Disk, set the camera’s
communication mode to [Normal].
The settings on this page are only necessary for the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.
With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on
changing, see the Canon website.

Check that the camera is not connected to the computer and then
set the camera’s power switch to <ON>.

Set the camera’s communication mode to [Normal].

Set [Communication] in menu to
[Normal].

With the EOS DIGITAL REBEL/
300D DIGITAL, set
[Communication] in menu option
<¥T72> to [Normal].

Press the <MENU> button to switch the LCD monitor display off
and then set the camera’s power switch to <OFF>.

0 If you set the communication mode to [PTP], the Solution Disk software cannot
communicate with the camera. When you are using the software, always set the
communication mode to [Normal].

When setting the communication mode, always ensure that the camera is not
connected to the computer beforehand. Setting the communication mode while the
camera is connected to the computer will cause camera and software malfunctions.

About the PTP Setting

The PTP function is only available to OS X users. This function provides a simple means of
downloading JPEG images to your computer. To use this function, set [Communication] to
[PTP] in step 2 above.
For more information on using the PTP function to download JPEG images, see
“Downloading JPEG Images Using the PTP Function in OS X (10.1 or later)” (M-12).

M-8



Connecting the Camera to Your Computer

Before downloading images to your computer or specifying the camera settings, you must
connect the camera to your computer with the dedicated USB cable.
You can connect the camera while your computer is running.

With the EOS Viewer Utility for OS 9, you cannot download images (M-18), specify
camera settings (M-50), or take shots remotely (M-53) by connecting the camera and

your computer.

D Set the camera’s power switch to <ON>.

Plug the dedicated cable into the computer.

Plug the cable into the USB port.
Refer to the computer User’s
Manual for information on the
terminal areas.

Plug the dedicated cable into your camera.

Open the cover and connect the
cable to the <DIGITAL> terminal
with the [+ ] icon facing the front
of the camera.

With the EOS D60 and EOS D30,
connect by aligning the <»> mark
on the plug with the <P>> mark on
the <DIGITAL> terminal.

- The camera is now ready to
communicate with your computer.
Proceed to Chapter 3
continuously.

-

M-9
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Connecting the Camera to Your Computer

0

Never perform the following operations while the software installed from the Solution

Disk is running after connecting the camera to the computer as a communications

error may occur.

« Set the camera’s power switch to <OFF>.

» Open the CF card slot cover.

« Disconnect the dedicated cable, remove the battery, and then remove the AC
adapter kit (optional) or DC coupler.

« Disconnect the AC adapter’s or DC coupler’s plug or power cord.

Before you perform the operations above, be sure to quit all the software.

You cannot communicate with the camera when you are displaying images through

the camera’s LCD monitor. Always connect the camera and your computer after

turning off the display in the LCD monitor.

While the camera and your computer are communicating, the camera’s LCD panel

may blink.

Use only the dedicated cable.

Push the plug firmly all the way into the socket. Loose connections can cause faults

or malfunctions.

Do not connect the camera to your computer via a hub. If you do so, the camera may

not operate correctly.

If you connect multiple USB devices (excluding mouse and keyboard) to your

computer, the camera may not operate correctly. Disconnect other USB devices from

your computer and connect only the camera.

Operation of the Auto power off function will automatically switch the camera off,

disabling to communicate with your computer. Set the Auto power off function to

[OFF] in advance. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

Do not connect more than one camera to the same computer. The connections may

not operate correctly.

When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull

it out.

* If you are using the EOS D60 or EOS D30, pull the plug while pressing the PUSH
button on it.

If you do not perform any operation while the camera and computer are connected, a

confirmation message appears on the computer screen asking whether you wish to

continue communicating with the camera for some computer systems. If you do not

perform any operation even after this message appears, the communication with the

camera is terminated. To re-establish the communication, press the shutter button

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

Do not put your computer to sleep while it is connected to the camera.

If your computer goes into the sleep mode, never disconnect the dedicated cable

while your computer is still in sleep mode. Always wake your computer up while it is

connected to the camera. On some types of computer, disconnecting the dedicated

cable while your computer is in sleep mode could prevent the computer from waking

up correctly. Refer to the computer User’'s Manual for more information on sleep

mode.



Connecting the Camera to Your Computer

I:Eﬂl When you connect the camera and your computer, it is recommended that you use an
AC adapter kit (optional) with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D
DIGITAL, and the DC coupler supplied with the EOS D60 and EOS D30.

Using Your Card Reader mmmm

Users with a third-party card reader can download images directly from a memory card to the
computer.

1 Remove the memory card from the camera.

Load the card into the card reader.

©® Proceed to Chapter 3
continuously.

I:Eﬂl For information on connecting the card reader to your computer, refer to the card reader
User’s Manual.

Preparation for Downloading Images H



Downloading JPEG Images Using the PTP Function in OS X (10.1 or later)

Users of OS X (version 10.1 or later) can use the PTP (Picture Transfer Protocol) function. The
PTP function allows you to download JPEG images saved on a memory card in the camera to
your computer without having to start the software provided on the Solution Disk.
This function is available with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D
DIGITAL only.
With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on
changing, see the Canon website.

Set the camera’s communication mode to [PTP] (m-8).

Set [Communication] in menu to

[PTP]. 7
With the EOS DIGITAL REBEL/ Dat /Time :
300D DIGITAL, set File numbering

. . . . uag
[Communication] in menu option Language

<¥72> to [PTP].

Video system
Communication  Normal
Press the <MENU> button to Format

clear the LCD monitor display. Custom Fun
When you have finished, set the
camera’s power switch to <OFF>.

Connect the camera to the computer and set the camera’s power
switch to <ON> (m-9).

Image Capture or iPhoto starts up. ‘ges P -

You can specify which software Y < e R

starts up in Image Capture. - E

Download the images as directed.
» Follow the instructions in the on-screen messages to download the JPEG images.

0 Refer to the separate “Notes on the PTP Function” for details when the downloaded
image does not display correctly or the image cannot be downloaded.

F—ﬁ_l To specify the software that will start up when the camera is connected to the
computer, start up Image Capture and select [Preference] in the [Image Capture]
menu. In the [Image Capture Preference] dialog box, select the application in the
[When a camera is connected, open] list box.

Image Capture and iPhoto are software bundled with OS X. For detailed information
on using these applications, refer to the Help provided in the respective application.



Working with Images in
the EOS Viewer Utility

This chapter explains how to use the EOS Viewer Utility to download images
to your computer, edit and save images, and transfer the downloaded

images to the retouching software.

For more information on the restrictions of the EOS Viewer Utility, refer also to the

source listed below.
ReadMe:
» [ReadMe].

Double-click the [Canon Utilities] folder B the [EOS Viewer Utility] folder

Starting the EOS Viewer Utility.... M-14

Downloading Images.... .. M-18
Handling the Folders.................... M-20
Memory Card Folder Structure and File
NamMeS ....evieiiieeeee e M-20

Registering Frequent Use Folder ...M-21
Selecting the Image Display Mode ...M-22
Main Window (Thumbnail Display)...M-22

Preview Window Display............. M-22
Selecting the Display Size .......... M-24
Checking the AF Point................. M-24
Selecting Images ..........ccovunneriueaes M-25

Selecting Images in the Main Window .. M-25
Selecting Images in the Preview Window .. M-25
Attaching Check Marks to Images...M-26
Selecting Images by Condition ... M-26
Bringing/Sending the Main Window to
the Front/Back of Window Stack ... M-27
Equalizing the Display Sizes of the
Preview Window .........................
Editing Images.......
Protecting Images
Rotating Images...........ccccceuenee.

Deleting Images........cccceoiiiianen M-29
Checking the Image Information and
Entering Comments.................... M-29
Printing Images........cccccviirncnnnnnn M-30
Editing RAW Images ........ccocoueuuen M-31
Processing RAW Images............ M-31

Specifying the Processing Parameters ..M-32
Adjusting the Brightness (Digital

Exposure Compensation)........... M-33
Adjusting the White Balance........ M-34
Selecting the Contrast ................ M-37
Adjusting the Color ..................... M-38
Specifying the Color Space ........ M-40
Selecting the Sharpness............. M-40
Saving Images .......ccovnivrieininennns M-41
Extracting JPEG Images from RAW
[ 4 F=To [T SR M-43
Transferring Images to Retouching
Software ......ccoccvviiiiiinicinnns ... M-44
Specifying the Preferences ......... M-46

Setting the IPTC Information....... M-47
Specifying the Camera Settings....M-50
Merging Images with the PhotoStitch...M-52




Starting the EOS Viewer Utility

Connect the camera to your computer (M-9).

Double-click the [Canon EOS Viewer Utility] icon on the desktop.

The main window appears.
You can also start the EOS Viewer Utility by double-clicking the [Canon Utilities]
folder B the [EOS Viewer Utility] folder B> the [EOS Viewer Utility] icon.

M-14



Starting the EOS Viewer Utility

Main window tool bar

Path display
Displays the folder path

selected in the Tree View Area.

800

B w s W
s

Status bar

Bookmark area (M-21)

Tree View Area (M-18)

—— R OE

Main window

Image information display area

Histogram Displays basic shot information.

Shows the distribution of the brightness of an image.
Selecting the tab switches the histogram display
values between Brightness and RGB.

iy | b gy e o P | KTHT A

FRij~“BN I=% 5 & 80

! 1
s -

Image display area

RGB value display

When you move the cursor over an image, the
coordinates of the cursor position and its RGB values
(8-bit conversion) are shown here.

Comment input box (M-29)

Detailed Information display area (M-29)

® For OS X, to quit the EOS Viewer Utility, select the [EOS Viewer Utility] menu P [Quit EOS

Viewer Utility].

® For OS 9, to quit the EOS Viewer Utility, select the [File] menu P> [Quit].

Working with Images in the EOS Viewer Utility H



Starting the EOS Viewer Utility

Main window tool bar

Rotate left 90 degrees button (M-28)

) . Rotate right 90 degrees button (M-28)
Show/Hide Thumbnail Frames button

Showst/hides the information display frame Remove Check Transfer images
of thumbnail images. Mark button (M-26) button (M-44)

Display Size Window button Remove protect button Erase images
list box (M-24) (M-27) (M-28) button (M-29)

_Large B @3@E Fhv xHR O & &
Show/Hide Tree View button EOS Capture
Shows/hides the Tree View Area. button (M-54)
Show/Hide Image Information button Save File button
Shows/hides the histogram, image information (M-41)
display area, Detailed Information display area,
angcgmment input box. Pla Select Image button

(M-26)
Add Check Mark button (M-26) IPTC information button
(M-47)

Play sound button

*This button does not work with
the camera you are using.

protect button (M-28)



Starting the EOS Viewer Utility

RAW adjustment tool palette

Displays the name of the 6] RAW adjustment
camera on which the selected —m————
RAW images were taken. EQS XXX

Digital Ecposure Compensation

Digital Exposure ==
Compensation slider (M-33) 8 : : pv : ] 0.0
o +1

-2 -1
‘White Balance

I— Color Temp. input box (M- 35)
White Balance list box —————auto e Click White Balance button
(M-34, M-35)

a+\ATD (M-36)

B
White Balance Compensation —E ARERRENEI —
. * G M o o

1,2,8
Sl|der(M'37) (R R |

Cantrast

Contrast list box (M-37) ~standard s
Parameters
Standard radio button ——= siandard
(M-38)": 23 Colar Saturation:  standard | 32— Color Saturation list box (M-38)
L0\ T an: "o T#*— Color Tone list box (M-38)"
B/W radio button (M-38)"1 23 < Biw
I Eere nNone = Filter Effect list box (M-39)"1: 23
NN wname i——Toning Effect list box (M-39)" 23
Color Space
(skce— T#3— Color Space list box (M-40)2 3
Sharpness
Sharpness list box (M-40) Off -
Reset to Shot Settings button
( Reset ta Shot Settings —_ (M-32)
Preview checkbox (M-32) —————=# Freview E_— Update button (M-32)

When you select a RAW image, the name of the camera on which the selected RAW image
was taken and its settable processing parameters are displayed.

"1 Not displayed with the EOS 10D and EOS DIGITAL REBEL/300D DIGITAL.

2 Not displayed with the EOS D60 RAW images.

3 Not displayed with the EOS D30 RAW images.

0 » Where you have selected a JPEG image or where you have selected a TIFF or JPEG
image converted from a RAW image with the EOS Viewer Utility, nothing is displayed
on the RAW adjustment tool palette and the image cannot be edited.

Where you have selected a RAW image saved on the memory card inside the
camera, nothing is displayed on the RAW adjustment tool palette and the image
cannot be edited. Work with the images saved on your computer from the memory
card.

F—ﬁ_l The settings used when shots were taken are displayed in italic or bold type in the list box.
©® If the RAW adjustment tool palette is hidden, select the [View] menu P> [Tool palette] to
show it.

M-17
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Downloading Images s

The procedure below describes how to download (copy) the images saved on a memory card
in the camera to your computer, and display them on the main window. You can download
images in the Tree View Area.
©® This function is only available with the EOS Viewer Utility for OS X.
With the EOS Viewer Utility for OS 9, you cannot download images saved on a memory
card inside the camera. Download images to your computer by either using the EOS Viewer
Utility for OS X or by using a third-party card reader.

Create a folder to which images will be downloaded.

© From the menu that is displayed - - —
by clicking on the destination Medum Bl d  @mE S (4D
folder while pressing the <control> ~ * B E05 X

key, select [New folder] to create a " 5 :{'ms Open
ar

folder and enter a nar:ne for the (

folder. (Enter [Photo] in the folder
name field here as an example.)

Display a folder to be copied.

® Double-click the camera icon »
IMe g 4 o
the [DCIM] folder. Medum Aok £
) v il Fosiex
=» The [xxxCANON] folder is = P .
displayed. (“xxx” represents a
number 100 to 999.) v 3 Hug-,'x

- I Appacations
¥ ceskiop Folder
B Pheas

» B Users

B Macosa

Copy the folder to the hard disk.
® Drag and drop the [xxxCANON] v B o

folder to the destination folder. - L nrm
= The [xxxCANON] folder is saved _ B sxncanon
on your computer. v Bl Macosx
» M Applications
|4 Desxtop Folder
W Fheto [71

L e Users
F B Maosa?




Click the copied folder.

=» The images in the folder are

Y B eosaxx
displayed. - (7 oom
© Before disconnecting the camera B cocanon
from the computer, quit the EOS v 3 Mars
L & applicanians

Viewer Utility, set the camera’s
power switch to <OFF>, and then i Ghern

disconnect the dedicated cable. N

e & Usars
E S Mac0s 9.2

4 Deskiop Folcer

Downloading Images

0 © You cannot display images in the preview window (M-22) or edit RAW images (M-31)
saved on a memory card in the camera directly. Work with the images saved on your

computer from the memory card.

© For displaying images saved in a third-party card reader, follow the same procedure

to download the target folder to your computer.

Supported Image Formats
The images below can be displayed with the EOS Viewer Utility.

Image Format File Extension

RAW images taken with the EOS-1D Mark Il and the EOS 20D .CR2
RAW images taken with the EOS-1Ds and the EOS-1D .TIF
RAW images taken with the EOS 10D, DIGITAL REBEL/300D DIGITAL,

.CRW
D60 and D30
JPEG images conforming with the Exif 2.2, 2.21 standard* JPG/.JPEG
TIFF images conforming with the Exif standard* .TIF/.TIFF

* Includes TIFF and JPEG images converted from RAW images and saved with the EOS

Viewer Utility.

0 ® Images that cannot be displayed appear as a question mark [?].

© The images that are processed on your computer after being shot or the images

whose file name is changed may not be displayed properly.
© You cannot use the camera while displaying images on the camera.

I:Eﬂl © By setting [Auto rotate] setting to <ON> for the camera with this function, images shot

in a vertical position are automatically displayed vertically.

© If the selected folder contains a large number of images, there may be a short delay

before the images appear.

Working with Images in the EOS Viewer Utility H



Handling the Folders My

You can handle the folder on the menu that appears by clicking on the folder while holding
down the <control> key.

Click on the folder while holding down the <control> key, and then
select an option from the menu that appears.

Medium My @R (F

v B Wacosx
* & spplications
|4 Deskop Folder
| B Photi
Opens the selected folder.
3 3 user
Creates a new folder. Note that you =5 New folder

cannot create a new folder in the ch 14
memory card in the camera. ange Folder Name

Allows you to change the folder name.

I:Eﬂl You can drag and drop folders from the Tree View Area to the other folders.

Memory Card Folder Structure and File Names
_m ﬁ IMG_YYYY.JPG: JPEG image

DCIM xxxCANON IMG_YYYY.CR2: EOS 20D RAW image
CRW_YYYY.CRW: EOS 10D, EOS DIGITAL REBEL/300D
DIGITAL, EOS D60, EOS D30 RAW images
ﬂ— CRW_YYYY.THM: Image for displaying the camera’s index
B— The folder that holds the image control files in the DCIM folder.
CANONMSC

_D The folder created when DPOF settings are set.
It holds the DPOF settings files.
MISC

©® The “xxx” in the folder names represent a number between 100 to 999.
® The “YYYY” in the file names represent a number between 0001 to 9999.

I:Eﬂl The file name of images shot with the EOS 20D is “_MG_" (the first character is an
underscore) when Adobe RGB is set.
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Handling the Folders

Registering Frequent Use Folder

You can register frequent use folders as bookmark folders.

1 Display a folder to be registered (m-18).

Register a folder as a bookmark folder.

© Drag and drop the folder to be
registered as shown on the right.

=» The folder icon appears in the
Bookmark area when it is
registered.

© To delete the registered folder,
click the folder while holding down
the <control> key and select
[Delete] from the menu that
appears.

—

Hookmark

I:Eﬂl © You can also reorder the folders in the Bookmark area by dragging and dropping them.
© When you delete the registered folder, it just disappears from the Bookmark area.
The actual data of the folder and the images in that folder will not be deleted.

M-21
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Selecting the Image Display Mode

You can select the display size and method of images.

Main Window (Thumbnail Display)

Various information can be displayed with images.

Display number — 8 ———1 0.0— Digital exposure

Numbers are assigned compensation value (M-33)
sequentially to the displayed
images starting with the first
image.

8 — Recording quality

The [RAW] and [RAW+JPEG]

symbol are displayed for RAW

and RAW+JPEG images

respectively. No symbol is

displayed for JPEG images.

* Only images taken with the EOS
20D in RAW+JPEG format
display the [RAW+JPEG]

symbol.
IMG_0001.CR2
Check mark (M-26)
File name or shooting date/time This mark is displayed on images
The items selected in the [Image Lower for which a check mark was
Display Item] list box in the [Preferences] attached.

dialog box (M-46 displayed.
talog box ( ) are displaye Protect mark (M-28)

This mark is displayed on protected images.

Preview Window Display

Double-clicking an image displayed on the main window can enlarge the image.

When you change the processing parameters of RAW images, use this window.

® The preview window can display a maximum of six previews.

© Alow resolution image is displayed first in the preview window, and then it changes to a high
resolution image.

Preview window

Preview tool bar RAW adjustment tool palette

P T
e "

-
- —— s
W
. o
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Selecting the Image Display Mode

Preview tool bar

JPEG preview button

Changes the image displayed in the preview window to a RAW or JPEG image.
*Only compatible with EOS 20D RAW+JPEG images and EOS 10D, EOS DIGITAL
REBEL/300D DIGITAL and EOS D60 RAW images.

Remove Check Mark button (M-26)

Show/Hide Image
Information button

Shows/hides the
histogram, image

Remove protect button (M-28)
IPTC information button (M-47)

Display Size
list box (M-24)

information dispaly area,
Detailed Information
display area, and
comment input box.

Save File button (M-41)

Select Next Image
button (M-25)

Fir to window  Fo | [

BR | ES w H ] @2 & 4k @&

Window button (M-27) Erase images
button (M-29)

Select Previous
Image button

Rotate left 90 degrees button (M-28)

Rotate right 90 degrees button (M-28) (M-25)
Transfer images button
Add Check Mark button (M-26) (M-44)

Display AF point button (M-24)

*Only compatible with EOS 20D, EOS
10D and EOS DIGITAL REBEL/300D
DIGITAL images.

Play sound button

*This button does not work with the camera you are using.

Protect button (M-28)

0 You cannot display images in the preview window or edit RAW images (M-31) saved on
a memory card in the camera directly. Work with the images saved on your computer
from the memory card.

I?—ﬁ.l » For some images, it may take some time to change to the high resolution image.
You can set the image displayed in the preview window to RAW image or the
simultaneously recorded JPEG image (M-46).

M-23
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Selecting the Image Display Mode

]
Selecting the Display Size

Select a display size from the list box.

© In the main window, the available Main window
image sizes are [Small] (64 X 42 . . - = :
pixels), [Medium] (100 X 66 & EOS Viewer Utility File Edit
pixels), and [Large] (160 X 106 — 5;31?

ixels). = —
pixels) v Medium B ,-.-I‘ i
Large

| [ B L P

® In the preview window, the
available image sizes are [Fit to
window] and [100%].

©® When you select [100%], you can
change the display position by
dragging the image.

Preview window

Checking the AF Point

The AF point used when the shot was taken can be displayed.

© This function is only available with images of the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.

1 Display the image in the preview window (M-22).

Click the [Display AF point] button.

-> int is di .
. Wit o /xxxCANON /CRW_000L.CRW
© Clicking the button again hides the -

AF point. W B Hﬂ wn.& & | 4

I:Eﬂl When the shot was taken with automatic AF point selection, multiple active AF points
might be displayed.
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Selecting Images

Selecting Images in the Main Window

Click the target image.

=» The frame around the selected
image is colored.

© To select multiple images, hold
down the <shift> key and click the
images.

© To select sequential images, click
the firstimage and then hold down
the <option> + <shift> keys and
click the last image.

I:Eﬂl Alternatively, you can use the arrow keys (T «<—{) on the keyboard to select images.

Selecting Images in the Preview Window

Click the target image.

-» The selected image is displayed
on the top window.

©® When only one preview window is
displayed, you can click the
[Select Previous Image] button or
the [Select Next Image] button to
select the image to be displayed.

JCRW_0001.CRW _
moe@m & a(dp) i
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Selecting Images

]
Attaching Check Marks to Images

You can attach a check mark to the RAW image, allowing you to select images more easily.

Click the [Add Check Mark] button.

-» When the check mark is placed, ’ EOS Viewer Utility - Folder
the [«# ] icon appears in the frame N

of the image. B 5 |§| %(V ’& B N

® Clicking the [Remove Check Mark]
button removes the [+ ] icon from &P Eos Viewer Utility - Folder - Mac(

the frame of the image, and = ‘ & | Wl 3 ) [ ‘ [0 e ‘E

erases the check mark.

0 You cannot attach the check mark for any images other than RAW images.

I:Eﬂl © When multiple RAW images are selected, the check mark is attached to all the
selected RAW images.

© Alternatively, you can perform the same operation using the menu that appears by
holding down the <control> key and clicking.

Selecting Images by Condition

This feature allows you to select multiple images in a single operation using conditions.

Click the [Select Image] button and select the condition from the
menu that appears.

=» Only images that meet the
condition are selected. I | 5 & | i)
| Select All R
Select all checked images
Select all unchecked images
Select all protected images
Select all unprotected Images
Delete Selection
LA |
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Selecting Images

Bringing/Sending the Main Window to the
Front/Back of Window Stack

Select [Move main window to front] or [Move main window to
back] from the menu that appears by clicking the [Window]
button.

=» The main window is brought/sent - : -
to the front/back of window stack. 21 B N VIR |m| [ (T

Move main window to front
I Move main window to back I

SLATIUEIUIZE DI EVIEW WITIUOW 5iZe

Equalizing the Display Sizes of the
Preview Window

You can set all the preview windows to the same size.

Select the image whose size is the desired size (M-25).

v

1L P

e B EE FY o=@

Click [Standardize preview window size] from the menu that
appears by clicking the [Window] button.

=» All the displayed preview windows : — s
are set to the same size as the IR P ® v B omE

selected image. Mowve main window to front
Aamiin maaiem arimedaar ko o sl
Standardize preview window size
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Editing Images
You can edit all the images that can be displayed in the EOS Viewer Utility.

I?—ﬁ_l When multiple images are selected, the edits are applied to all the selected images.

Protecting Images

You can protect important images to prevent them from being accidentally deleted.

Click the [protect] button.

Wher.1 the image is.protected, the @ EOS Viewer Utility - Folder - MacOS X,
[[E=]] icon appears in the frame of

the image. @%W \‘El’\\

Clicking the [Remove protect] = =
EOS Viewer Utility - Folder - MacOS X/Ph
button removes the [[=]] icon from & N\

the frame of the image, and clears P v BB &

the protection.

F—ﬁl The [[e=]] is automatically displayed for images that were protected on the camera.

Protection only prevents images from being deleted. Other types of image operations
can still be performed for protected images.

Alternatively, you can perform the same operation using the menu that appears by
holding down the <control> key and clicking.

Rotating Images

You can rotate a selected image by 90-degree increments left or right.

Click the [Rotate right 90 degrees] or [Rotate left 90 degrees]
button.

=» The image rotates 90 degrees in

; @ EOS Viewer Utility - |
the selected direction. ————

EEa(@E® ) BN

F—ﬁl By setting [Auto rotate] setting to <ON> for the camera with this function, images shot
in a vertical position are automatically displayed vertically.
If a rotated image is displayed in another application, the image may not appear
rotated.

® Alternatively, you can perform the same operation using the menu that appears by
holding down the <control> key and clicking.
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Editing Images

Deleting Images

You can move unnecessary images to the Trash on your computer and delete them.

Click the [Erase images] button.

=» The images are moved to the X/Photo/ xxxCANON

Trash.
& & (ﬁ-. )

Select the [Finder] menu on the desktop P> [Empty Trash].

® For OS 9, select the [Special] menu B> [Empty Trash].
-» The images are deleted.

0 © Images that you deleted by selecting [Empty Trash] in step 2 cannot be restored.

Check carefully before deleting images.
© Protect important images (M-28) to prevent them from being accidentally deleted.

I:Eﬂl Alternatively, you can perform the same operation using the menu that appears by
holding down the <control> key and clicking.

Checking the Image Information and Entering Comments

You can check the information recorded with images and input comments.

Detailed Information display area
@ The shooting information is displayed.
The number of items displayed differs depending on the camera settings.
® You can copy the information as text data and paste it into another application.
® Clicking the [¥] button can hide the Detailed Information display area.

9 Bt s

="

Comment input box

= You can use this box to type in a
- comment up to 120 characters long.
Type in your comment and press the
<return> key.

o You cannot insert a hard return in the comment input box.

I:Eﬂl When multiple images are selected, the information from the image selected last is
displayed.
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Printing Images

You can use the EOS Viewer Ultility to print images in index format.

Select images to be printed in index format (m-25).

Select the [File] menu P> [Print Index].
The Printer Setup dialog box appears.

Select the printer to be used, specify the print settings and print
images.
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Editing RAW Images

You can specify the processing parameters for RAW images so that the RAW images are
optimized for their intended purpose.

Processing RAW Images

RAW images are processed based on the settings specified on the camera (including the
processing parameters and white balance) and then displayed on the computer.

When the following operations are performed, RAW images are processed and displayed:
* When the preview window is switched from the main window

* When the processing parameters are specified on the preview or main window

* When the image is converted to the TIFF or JPEG format and saved

* When the image is transferred to the specified retouching software

When the images are processed, it takes a while to display them.

Approximate processing times

Opsiationibetails Switching from the main Transferring an image to the
Camera Model window to the preview window | specified retouching software
EOS 20D Approx. 5 sec. Approx. 45 sec.

EOS 10D Approx. 4 sec. Approx. 35 sec.
E&%%%IQ\LLREBEL/ Approx. 4 sec. Approx. 35 sec.
EOS D60 Approx. 4 sec. Approx. 30 sec.
EOS D30 Approx. 4 sec. Approx. 25 sec.

» The processing times given here are only approximations. Actual processing times
vary widely depending on the images and the computer system.

» Processing times are based on Canon testing standards.
(OS: OS X 10.2; CPU: Power PC G5 1.6 GHz; RAM: 256 MB)

» The processing time in the retouching software includes starting up time of the retouching
software (when using Adobe Photoshop 7.0).

0 You cannot display images in the preview window (M-22) or edit RAW images saved on

a memory card in the camera directly. Work with the images saved on your computer
from the memory card.
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Editing RAW Images

Specifying the Processing Parameters

You can specify the processing parameters in the RAW adjustment tool palette.
This processing applies the specified parameters virtually and does not affect the original
RAW images in any way. Consequently, you can redo the processing as often as you like
with different parameters and then reset the modified parameters to the settings used when
the shot was taken.
Linear processing can be specified when an image is saved (M-41) or is transferred to
retouching software (M-44).
The procedure below is an operating method in the preview window, but you can set
processing parameters with the same operation in the main window also. However, in the
main window, you cannot click the [Preview] checkbox and the processing parameters you
have set are immediately reflected in the image.

Display the RAW image in the preview window (M-22).
If the RAW adjustment tool palette is hidden, select the [View] menu P> [Tool palette]
to show it.

Specify the processing parameters (M-33 to M-40).

Clicking the [Reset to Shot Settings] button restores the settings to the values used
when the shot was taken.

If you click the [Preview] checkbox, the specified processing parameters are applied
to the RAW images

Click the [Update] button.

The RAW images are processed
according to the specified
processing parameters. ‘ Reset toShot Settings

v Proview ‘ / Update \’

t Save (M-41) or transfer images (M-44).

.

0 The processing parameters set with the EOS Viewer Utility in the RAW images of a
camera other than the EOS 20D are cancelled when you quit the EOS Viewer Utility, and
are reset to the processing parameters for when shooting. Either convert the RAW image
specified with the processing parameters to a TIFF or JPEG image and save (M-41), or
transfer to retouching software (M-44) and save.

F—ﬁ_l When multiple images are selected in the main window, the specified processing
parameters are applied to all the selected RAW images.
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Editing RAW Images

Adjusting the Brightness (Digital Exposure Compensation)

You can adjust the brightness of an image in the range of +/—2 stops in 0.1-stop increments.
© This function is only available with RAW images of the EOS 20D, EOS 10D, EOS
DIGITAL REBEL/300D DIGITAL and EOS D60.

Drag the slider left or right to adjust the brightness.

=» The adjusted value is specified in

; Digital Exposure Campensation
the RAW adjustment tool palette.

Adjustment value set with the slider.
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Editing RAW Images

]
Adjusting the White Balance

You can adjust the white balance in the images.

Selecting the White Balance

You can select the white balance that is the closest to the light source when shots were taken.

Select the white balance from the list box.

© [Shade] and [Color Temp.] are not wihite Balance
displayed for the EOS D60 and

EOS D30 RAW images. | v S:JEQM ) K 2
| shade s T o0
|, ey
| Fluorescent E' SLInn
Flash 3
Color Temp. £ ( Standard )
White Balance Details Cuzl((gtmf'
Auto Automatically adjusts the white balance. Approx. 3000 to 7000
Daylight For sunny daylight outdoors. Approx. 5200
Shade For shaded areas outdoors. Approx. 7000
Cloudy For cloudy or hazy days and during sunset. Approx. 6000
Tungsten For tungsten (light bulb) light. Approx. 3200
Fluorescent For white fluorescent light. Approx. 4000
Flash When flash is used. Approx. 6000
Gl o | e k). | 4570 220010 1000

*  Approximately 5500 with the EOS D30 RAW images.

-» The selected white balance is specified in the RAW adjustment tool palette.
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Editing RAW Images

Specifying the Color Temperature
You can specify the color temperature to adjust the white balance.

© This function is only available with RAW images of the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.

1 Select [Color Temp.] from the list box.

White Balance

4 «  Auto ' K j
Daylight o

|  Shade o o
Cloudy [EEERRREE —

1 Tungsten _M a L

Fluorescent Frrrrrrnd

Color Temp. ) Standard |+]

Enter a color temperature.

© Enter the color temperature in the White Balance
[Color Temp.] input box in the

range of 2800K to 10000K (in { Colar Temp. E« 5200 K) &

100K increments).

=» The entered color temperature is
specified in the RAW adjustment
tool palette.
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M

Working with Images in the EOS Viewer Utility H



Editing RAW Images

Click White Balance Function

Makes white the standard for the part you have selected and automatically adjusts the white
balance.

Click the [Click White Balance] button.

- -
When you move the cursor over Wikite Balance

the image, the cursor [ k ]
changes to [ 2*]. Auto K @

Click the part where white is to be the standard.

ann Macisnaah 1O Pihete | LEOCANON TRIC, DO CRI
Famendis B8 BB F Y v BE D@ H W4

EEULE L L

-» The white balance is adjusted so that the point clicked appears white.

Iﬁl © When you use Click White Balance Function, even though you do not click the
[Preview] checkbox, the adjusted white balance is applied to the images.
® When you use Click White Balance Function, [White Point] is displayed in the [White
Balance] list box.
© You can adjust by selecting the neutral gray parts of the image.
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Editing RAW Images

Correcting the White Balance

You can correct the standard color temperature of the white balance. By using this function, you
can obtain the effectiveness similar to the color temperature converting filter or color
compensating filter (third-party product). The range of compensation is 9 levels for each color.
This function is especially useful for users who understand the role and effect of the color
temperature converting filter or color compensating filter.

© This function is only available with the EOS 20D RAW images.

Drag the slider left and right to adjust the white balance.

The corrected value specified using the slider.

Dragging the slider toward B-side adds
blue hue, and toward A-side, amber hue. —| s -
=" "A
e I._l o o ]
G * 4 M

{0 B B B B IR BB R R R R A
Dragging the slider toward G-side adds

green hue, and toward M-side, magenta hue. Correction value when shooting.

=» The corrected value is specified in the RAW adjustment tool palette.

I:Eﬂl One level of blue/amber hue is equal to five mireds of the color temperature converting
filter. (Mired: the unit of the density of the color temperature converting filter)

Selecting the Contrast

You can adjust the contrast of an image.

Select a setting from the list box.

=» The selected setting is specified in WP

the RAW adjustment tool palette. Contrast ﬂlw | ——

© [Mid.Low] and [Mid.High] are not | « _ﬂa‘;dﬂd B
displayed for the EOS D60 and Parametets ———— Mid.High |
EOS D30 RAW images. B\ <romian High
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Editing RAW Images

Color Adjustment

Select the color adjustment options with the radio buttons to make each type of adjustment.
© Selecting of color adjustment options is only available with EOS 20D RAW images.

Select the [Standard] radio button or the [B/W] radio button.
-» With the radio button you have

selected, you can make the a Standard
following color adjustments. Also, Color Saturation: | Stapdard [
if you select [B/W], the image will

Color Tane: [
become monochrome. a "‘ﬂ

[Standard]: Color Saturation, Color : B/W
Tone Filter Effect: AeName =
[B/W]: Filter Effect, Toning Effect =
© See the section below for Toning Effect: NeNane -
adjustment methods. = =
Selecting the Color Saturation
Select a setting from the list box.
-» The selected setting is specified in —
the RAW adjustment tool palette. a Standard ::LW
© [Mid.Low] and [Mid.High] are not Color Saturation: < Standard B
displayed for the EOS D60 and Mid.High
EOS D30 RAW images. Gaa T { High 3]

Adjusting the Color Tone

® This function is only available with the EOS 20D, EOS 10D, EOS DIGITAL REBEL/
300D DIGITAL and EOS D60.

Select a setting from the list box.

-» The selected setting is specified in

the RAW adi Color Saturation: | -3 @
justment tool palette. e
©® The more negative the value, the Caolor Tane: 1 B E
redder the image becomes, and — +1
the more positive the value, the L BfW +2
more yellow.

® [-2] and [+2] are not displayed for
the EOS D60 RAW images.
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Editing RAW Images

Filter Effect
© This function is only available with EOS 20D RAW images.

Select a setting from the list box.

=» The selected setting is specified in

the RAW adjustment tool palette. Filter Effect. i +  NeNome D
| Yevellow |
Toning Effect: Or:Orange 1
!: fRed
Color Space ———  Gelreen k
R M

Toning Effect
© This function is only available with EOS 20D RAW images.

Select a setting from the list box.

=» The selected setting is specified in

the RAW adjustment tool palette. T“""“!?{Eﬁﬂf {J NeNee B
- | S:5epia
ColorSpace —————  BiBlue _

& coen B

e ——————

Working with Images in the EOS Viewer Utility H
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Editing RAW Images

- 1]
Specifying the Color Space

You can set the color space of the images you have taken.
® This function is only available with RAW images of the EOS 20D, EOS 10D and EOS
DIGITAL REBEL/300D DIGITAL.

Select a setting from the list box.

-» The selected setting is specified in Color Space
the RAW adjustment tool palette. B

+ SRGE
Adobe RGE

“harnnrss

I:Eﬂl © The specified color space is recorded in the ICC profile attached to a TIFF image
converted and saved from a RAW image (M-41).
© An ICC profile contains color information, such as color properties and color spaces
of devices which are authorized by International Color Consortium (ICC). With this
ICC profile, many color management systems can minimize the color differences
between devices.

Selecting the Sharpness

You can adjust the edge sharpness of an image.

Select a setting from the list box.

© Higher values give higher levels of "
edge sharpening. J—DH E

® [Mid.Low] and [Mid.High] are not Sharpness LMT:LDW E—
displayed for the EOS D60 RAW T
aR3ges. Mid.High

© [Off], [Mid.Low] and [Mid.High] are High | ==
not displayed for the EOS D30 ¥ Recet tr Sk BN
RAW images.

-» The selected setting is specified in
the RAW adjustment tool palette.
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Saving Images

You can convert and save RAW images to TIFF or JPEG images, and save JPEG images as
another name. When you convert RAW images to the TIFF format and save them, the specified
color space data (M-40) is attached to each of images as the ICC profile automatically.

Select images to be saved (M-25).

Click the [Save File] button and select [Convert and save in file]
from the menu that appears.

The [Save File] dialog box ol T
appears. IEI e 2 | BN &S

‘ Convert and save in file... ’

T : ﬂ T =
Specify the settings and click the [OK] button.

The images are saved in the .
selected folder. s, S
P Cas o Meaginal Imag oo
Lard in ba ey ppecihed toide
i e O Dk Log
2] Chanity
Uotrest raisdumen) | e iR
" ac etai
T himtbis
PO wmgen o 14 A PN T barrvan wvw ws e ke ol
Mg Fageme
W i et 5y
P remaarmg @
sirte
[Tre—
[

Restores the settings to their —I

original ones and closes the  Applies the settings

[Save File] dialog box. and saves the image.

I?—ﬁ_l When you convert RAW images to the TIFF images and save them, the ICC profile is
attached to each of images automatically. An ICC profile contains color information,
such as color properties and color spaces of devices which are authorized by
International Color Consortium (ICC). With this ICC profile, many color management
systems can minimize the color differences between devices.

Alternatively, you can perform the same operation using the menu that appears by
holding down the <control> key and clicking.
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Saving Images

The image is saved as a new image in the same folder as the selected image.

T ER
. O Ypen o Carprsd v fdses
Allows you to specify the folder m————————————— (s i Fettoiing spaciad fokier
in which the image will be saved. e s e ot

When the [Save in following specified folder] radio button has been selected, this
button allows you to specify the folder in which the image will be saved. The
name of the destination folder is displayed next to the [Browse] button.

Select a setting for [Quality] (compression ratio) when you have selected [JPEG]
from the list box, from [4 (Highest image quality)] through [1 (High compression
ratio)]. Higher values give higher quality of the JPEG image.

P
41 0~ iy
[P PPLL pruages o il LAY S E o roasl e o aberh |
Click this checkbox to also save JPEG Specify the resolution for
images taken in RAW+JPEG format. saving images in a range
*This function is only available with of 10 to 2000 pixels/inch.
EOS 20D RAW+JPEG images.

If some of the images to be saved are RAW images, select [Do not convert], [JPEG], or [TIFF] for the
conversion format. If you select [TIFF], you can select the number of bits used when you save images from
[8bit/ch], [16bit/ch] and [16bit/ch linear]. If you select [JPEG], the images are saved in the [8bit/ch] format.
The extensions used for the saved files are shown below.

Conversion Format Extension
EOS 20D CR2
Do notconvert | g 10D, EOS DIGITAL REBEL/300D CRW
DIGITAL, EOS D60, EOS D30
JPEG (8bit/ch) JPG
TIFF (8bit/ch) TIF
TIF

TIFF (16bit/ch, 16bit/ch linear)
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Saving Images

Click this checkbox when you want to save
the image without changing the name.

Enter the number of digits in the sequential
number that attaches to the file and the
starting number used. A maximum of 9 digits
b il can be specified.

[ [ ]

This is text inserted before the file number. You can enter up to 12 characters.
When you enter text, an example appears in the [Example] field below the text box.

*This button does not work with the camera you are using.

Click this checkbox when saving the file after converting a RAW image to a JPEG image
or TIFF image adds one of the following at the end of the file name.

Conversion Format Conversion Format Name
JPEG RJ
TIFF (8bit/ch) RT8
TIFF (16bit/ch, 16bit/ch linear) RT16, RT16L

Extracting JPEG Images from RAW Images

A JPEG image simultaneously recorded with a RAW image can be extracted and saved.
This function is only available with RAW images of the EOS 10D, EOS DIGITAL
REBEL/300D DIGITAL and EOS D60.

The EOS DIGITAL REBEL/300D DIGITAL and EOS D60 simultaneously record a Middle/
Fine JPEG image and the EOS 10D simultaneously records the JPEG image set up in the
camera.

The contents that can be set are the same as [Save folder] and [File Name] of “Saving
Images” (M-41).

Select the RAW image from which a JPEG image is to be
1 extracted (m-25).

Click the [Save File] button and select [Extract & Save JPEG] from
the menu that appears.

The [Extract & Save JPEG] dialog
box appears.

B & B/
Cnnweart and cave in fila B
[( Extract & Save JPEG... )

Specify the desired settings and click the [OK] button.

) -» The JPEG image is saved in the selected folder.
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Transferring Images to Retouching Software

You can transfer the images displayed in the EOS Viewer Ultility to retouching software.
The descriptions given here use Adobe Photoshop 7.0, as an example.

0 In order to transfer images, you will need retouching software such as Adobe
Photoshop.
Be sure to specify the image transfer settings before transferring images.

Click the [Transfer images] button.

The [Transfer Images] dialog box
appears.

r = MacOSs X/Photo/xxxCANON

&j@ &

Click the [Browse] button.

The [Select application] dialog box Trames g

appears.

54 3w i O el kemage taider,
D farn o dlgming A ot Pk,
[ | -1 TR Ty SRS

Select the retouching software (Photoshop 7.0) to which the
image will be transferred.

Select the drive in which
Photoshop 7.0 is installed »
[Applications] folder » [Adobe
Photoshop 7] folder B> [Adobe
Photoshop 7]. Then click the
[Choose] button.

% Photoshop is specified and the
dialog box closes. f

Select mpplecation

Feaem: | 13 Adobe Paotothon 7 3

F Add v Favarites " Cancel E thoen A
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Transferring Images to Retouching Software

Select the radio button and then select a folder in which the
images to be transferred will be saved.

The images to be transferred are saved —————— saye in Griginal Image falder
as new images in the same folder. () Sawe in Rollowing specified folder.

lHacmeash HD/Users | xxx/ Deaktop

Click the [Browse] button and then select a folder in which the images
to be transferred will be saved.

Specify [Output settings] and [File Name] and then click the [OK]

button.
Tramife: snagss
e R L o
e ks Feotornop
L e o e TSl I [ y-we——

P ey o (gl Pmagm Subomr
PR DI W T

A7 5 4 e ENNK Biribinn i —
ChARsT g i =
e gl by
& main oot it (T et e
o Ak Joe

il g Lt
PP et o A A Tt e by e el

o Vi - —

i ot ey,
ST -
Mgt o iy
Tawt T
Eeapu

=)

® See “Saving Images” (M-41) for the procedure for specifying [Output settings] and
[File Name].

=» Photoshop starts up and displays the transferred images.

-» The transferred images are saved in the folder that you have selected in step 4.

I:Eﬂl © It is recommended that you should use the retouching software (third-party product)
that supports 16-bit images for the one to be specified for the transfer image function.
© When you convert RAW images to the TIFF format and save them, the specified color
space data (M-40) is attached to each of the images as the ICC profile automatically.
© Alternatively, you can perform the same operation using the menu that appears by
holding down the <control> key and clicking.
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Specifying the Preferences

You can specify the preferences for the EOS Viewer Ultility.

Select the [EOS Viewer Utility] menu P [Preferences].

The [Preferences] dialog box appears.

Specify the settings and click the [OK] button.
The settings are applied and the [Preferences] dialog box closes.

Select the information to be displayed below images
from [File Name] and [Shooting Date/Time].

Falevencey

RAW g
) PEC image
o) @
Restores the settingsto Restores the settings to  Applies the settings and closes
the default settings. their original ones and  the [Preferences] dialog box.
closes the [Preferences]
dialog box.

Displays the monitor profile set in the operating system.
Settings are made in the operating system.

Select whether the image displayed in the preview window is the RAW image or the

simultaneously recorded JPEG image.

* Only compatible with EOS 20D RAW+JPEG images and EOS 10D, EOS DIGITAL
REBEL/300D DIGITAL and EOS D60 RAW images.

Allows you to select whether the folder that was open the last time is displayed or
the specified folder is always displayed when the EOS Viewer Utility starts up.

If—ﬁ_l You can also select in the preview window whether the image displayed is the RAW
image or the simultaneously recorded JPEG image (M-22).

M-46



Setting the IPTC Information

IPTC stands for International Press Telecommunications Council and refers to a standard for
communications and information exchange tags attached to images. The standard was
established by newspaper and communications companies to allow problem-free transmission
of images.

You can attach this IPTC information to JPEG images, or to TIFF and JPEG images that were
converted from RAW images and saved with the EOS Viewer Utility. You can also save the
IPTC information on your computer, and then load the saved information and apply it to other
images.

Select a JPEG or a TIFF image (M-25).

Click the [IPTC information] button.

The [IPTC information] dialog box
appears.

wer Utility - Folder —lﬂacOS X/Photo/xxxCAl

\.EI\E_.A‘WT[ ) = & 1

Enter information (M-48, M-49).

Select any of [IPTC-1], [IPTC-2], or [IPTC-3] tab to display the tab sheet, and enter
the information.

The entered IPTC information can be saved on the dialog box that appears by
clicking the [Save As] button.

The saved IPTC information can be loaded on the dialog box that appears by clicking
the [Read] button.

Click the [Save] button.

% The specified IPTC information is applied to the image.

I Click the [OK] button.

w < The [IPTC information] dialog box closes.

I?—ﬁ_l IPTC information settings data saved on your computer is compatible with the EOS
Viewer Utility for both Windows and Macintosh.
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Setting the IPTC Information

Loads the IPTC information saved on your computer.
IPTC-1 tab IPTC-2 tab IPTC-3 tab

Saves the entered IPTC information on your
computer.

r— 1| Fro—r T ———

il =l

Cancels the entered IPTC information.

Displays the image for which you will enter
the IPTC information.

= When multiple images are selected,
this button displays the IPTC
e —— information for the previous image.
TR . When multiple images are selected,
r— this button displays the IPTC

information for the next image.

Displays the image No. in a sequence.

Displays the IPTC information entered before
the [Previous] or [Next] button was clicked.

Applies the entered IPTC information to the image.

Closes the [IPTC information] dialog box.

Settings on the [IPTC-1] tab sheet

A g
T e e el —
You can enter up to 64 characters. ———1= ———
You can enter up to 32 characters. ——— i T

You can enter up to 32 characters.. -
You can enter up to 2000 characters. v

You can enter up to 32 characters. ——————c iuen L
i
You can enter up to 32 characters. - =

You can enter up to 32 characters.
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Setting the IPTC Information

Settings on the [IPTC-2] tab sheet

wic- [ wi-n | s
You can enter up to 10 characters. ———ws 20 L::
Select [Highest Priority (=1)], [Normal (=5)], or ey — @)

[Low Priority (=8)] from the list box.
You can enter up to 256 characters. ——————— e s

You can enter up to 8 characters. =——————————— e

~S—
You can enter up to 11 characters, ——————————— ey e i p .h"
o LT
You can enter up to 32 characters.
Settings on the [IPTC-3] tab sheet
1 ] e —
Fs.i | et [_ﬁl f am
You can enter up to 3 characters. ————— s ::
You can enter up to 32 characters. ] >
You can enter up to 32 characters. imees o
s sy e e —
You can enter up to 256 characters. e L

You can enter up to 32 characters. ———————— =

v

You can enter up to 32 characters.
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Specifying the Camera Settings

You can specify the owner’s name and date/time in the camera.
This function is only compatible with the EOS Viewer Utility for OS X.
Connect the camera to your computer (M-9).

Start up the EOS Viewer Utility (M-14).

Select the [Options] menu P [Camera Settings].

The [Camera settings] dialog box appears.
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Specifying the Camera Settings

A Specify the settings.

Camera saflings

This box shows the camera
model, body ID (serial
number) and firmware

Enter the name of a camera
owner. You can enter up to
31 characters.

(-l version.
Imports the date and time
Enter a value or click the [A]/ it | from your computer.
[¥] buttons to specify the date O] ST Fraem L
and time.
[ A -

|
The battery level of the camera Wiy sl i This b h heth
L — is box shows whether a
is |nd|cat]e3vl:1);£1 %r]e%rsmg e memory card is loaded in the

[ ] !
the AC Adapter Kit (optional) or camera along with the

N available space on the card
DC Coupler, [ “ ]is displayed. and its total capacity.

[ SN = % You can also initialize the
’ ~|— memory card by clicking the
[Format] button.

Restores the parameters to their original ones
and closes the [Camera settings] dialog box.

Applies the settings that you have specified to the camera
and closes the [Camera settings] dialog box.

With the EOS D30, the [Parameters] button is displayed. For details on [Parameters],
refer to the Software Instruction Manual supplied with your camera.

Click the [OK] button.

The settings are applied and the [Camera settings] dialog box closes.

0 Formatting a memory card deletes all the data on the card. Because formatting also
deletes protected images, you should check the data recorded on the card carefully
before proceeding.
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Merging Images with the PhotoStitch =

You can merge multiple JPEG images to create a panorama shot.

1 Double-click the [Canon Utilities] folder P the [PhotoStitch] folder
» the [PhotoStitch Launcher] icon.

-» [PhotoStitch Launcher] appears.
2 Click the [Merge Images] button.
E (5] PhotoStitch Launcher

Canon
B PhotoStitch 3.1
Canon Utilities ﬂr‘ r-1e:g:nmag:s

PhntnStltch —

o
h-. Wiew and Print Marged Imagas

=» The PhotoStitch starts up.
© Follow the instructions in the guidance window to merge the images.
© Refer to the PhotoStitch Help menu for more details.

"B ()] Praansaitch =

T amend the merge results, ciick [Dispiay Seams] and oick on the areas you wish
10 change. Click [ Save)] if you will not make ary Emenoments or when you Tirish
he charges.

B of I 4 Pasadng (Soanary, # ) Fucul Longthy s Aol re — Cyson Prwsrihat

0 ©® You cannot merge RAW images in the PhotoStitch.
© Up to four images can be merged using the PhotoStitch.
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Remote Shooting in
the EOS Capture

This chapter describes how to use the EOS Capture for taking shots and
specifying the camera settings remotely from your computer.

For more information on the restrictions of the EOS Capture, refer also to the source

listed below.

Readme: Double-click the [Canon Utilities] folder B> the [EOS Capture] folder »
[ReadMe].

© Remote shooting in the EOS Capture is only available with the EOS 20D.

©® The EOS Capture is only compatible with OS X.

Starting the EOS Capture.......ccccooirmniiinsiinsiisne s e
Remote Shooting ......ccccceiiiiiiinic it
Single-frame Shooting ...
Timer Shooting ..............
Interval Timer Shooting ..............

Specifying the Camera Settings........ccccuieeciiiiiiirscce e M-59
Camera SettingS ......cuoviiieiiiiiee e M-59
White Balance Adjustment ..........cooouiiiiiiiiiiie s M-61
Specifying the Save Destination..............ccooieiiiiiiii i M-62




Starting the EOS Capture mmmmmmmms

©® Remote shooting in the EOS Capture is only available with the EOS 20D.
® The EOS Capture is only compatible with OS X.

1 Connect the camera to your computer (M-9).

2 Start up the EOS Viewer Utility (M-14).

Select the folder to save the 800

image In. . . Medium B @ps F%

© Select a folder in the Tree View » W E0S X0
Area to save the image in, or v B Marosx
create a new folder (M-18). (The . -

S
[Capture] folder is created here as
fader

an example.) —
| Phato
& Users
F O Mar0sg 2

L

Click the [EOS Capture] button.

=» The EOS Capture main window

appears. & @
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Starting the EOS Capture

EOS Capture main window

(N8 EOS XXX

7

M 125 ;5.5‘
5200 00
E mm+4aL =

Allows you to check and —

Specy ihe camera (< (:\I (:"-l {.  —Rotate button

9 ' et - N The image is downloaded,

rotating 90 degrees each

time you click the button,
regardless of the vertical or
horizontal position of the
camera.

*To use the rotation
function, click [On]
checkbox in [Save
settings] dialog box (M-62).

¥ button (M-61) v
Shows/hides the white e _
balance adjustment G R 5e buttogy(M-56)
dialog box. 7 Az |
s |
. (=] L ———
B A
l ¥ ol
M Status

Displays the status while
— specifying the settings.

5 Click the [Release] button to take a shot (M-56).

® If you quit the EOS Capture, select the [EOS Capture] menu P [Quit EOS Capture].

I:Eﬂl The EOS Capture operates in conjunction with the EOS Viewer Utility. Therefore, when
you quit the EOS Viewer Utility, the EOS Capture also quits.
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Remote Shooting

You can control the camera from your computer and take single-frame shots, timer shots and
interval timer shots. The images are automatically saved on your computer.

Single-frame Shooting

Set the camera up ready to shoot.

Make various settings.

See “Camera Settings” (M-59) and “White Balance Adjustment” (M-61) for
information on how to specify the camera settings.

See “Specifying the Save Destination” (M-62) for information on how to specify the
settings for saving images.

Click the [Release] button.

The shot images are displayed in

the EOS Viewer Utility and saved ol
in your computer automatically. D ﬂ m

0 Before you use the Remote Shooting function, be sure to check that the camera is ready
for shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you
cannot perform the operation as explained.

I:Eﬂl Alternatively, you can press the space bar to shoot.
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Remote Shooting

Approximate Transfer Time for Shooting RAW Images
| EOS20D |  Approx.5seconds |

* The transfer time given here is only an approximation. Actual transfer time varies
widely depending on the images and the computer system.

* The time for images shot in JPEG format will be shorter than those shown above.

* Transfer time is based on Canon testing standards.
(Time until images appear in the EOS Viewer Utility main window after you uncheck the
[Save also on the camera’s memory card] checkbox and click the [Release] button in the

EOS Capture main window using the following: OS: OS X 10.2; CPU: Power PC G5 1.6
GHz; RAM: 256 MB)

0 When the camera is set to One Shot AF, you cannot take shots if the camera cannot focus.
If you cannot take shots with the auto focusing, focus manually and then take a shot.

F—ﬁ_l The number of available shots changes depending on the available capacity on your
computer’s hard disk. You can check the number of available shots with the [Shots to
Go] (M-59).

Timer Shooting

Select the [Tool] menu P [Timer shooting].

The [Timer shooting settings] dialog box appears.

Enter a delay time and click the [Start] button.

@ You can set a value between 0 r
seconds and 99 minutes 59
seconds in 1-second increments.

Timer $hodting settings

Eeep the lellewing lor pralenged shaating
uging interval timer shooting.

- Timer shooting shots are taken.

Us# household AC cutlers for the camera and
PC.

Eelease the PC's power-3aving function.

Delay setting

Dilay time 1 ¢ i)

_! Imterval timar shaoting

tdnlfl
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Remote Shooting

Interval Timer Shooting

1 Select the [Tool] menu P [Timer shooting].

=» The [Timer shooting settings] dialog box appears.

2 Click the [Interval timer shooting] checkbox.

|w| timer $hooling
ranating interval 15+ _EI|

3 Enter the shooting interval and the number of shots. Then click
the [Start] button.

® You can set a shooting interval
between 5 seconds and 99
minutes 59 seconds in 1-second

Timer shooting Settings

Eeep the fellewing far pralonged shooting
uging interval timer shooting.

increments.
® You can set up to a maximum of Uise household AC curlats for the camers and
[
1999 shots.

; L Release the PCY i )
=» Interval timer shooting is the PC's power-saving function

performed using the specified Delay SARIY
interval between shots and the —— | —
specified number of shots. = . -
& intarval imar shasting — _—
Sheating interval J i)

Mo, of shots 2

0 On some types of computers, if you set a short interval between shots and there is
insufficient time to download and save the images, it may not be possible to take shots at
the specified interval. If this occurs, set a longer interval between shots and take the
shots again.
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Specifying the Camera Settings

You can check and change the settings in the camera from your computer remotely.

Camera Settings

You can check and specify the camera settings.

Check the camera settings.

Shutter speed

Displays/specifies Tv (shutter speed).

(Not displayed when Aperture-priority AE or Program
AE is specified for the shooting mode)

Aperture value

Displays/specifies Av (aperture value).
(Not displayed when Shutter-priority AE or
Program AE is specified for the shooting mode)

Color temp.

Specify the color temperature in a range
of 2800K to 10000K.

Shooting mode
Displays the shooting mode.

[ [
‘ |
M ,es F 5.5 | 10 Speed
150 Displays/specifies the ISO speed.
White Balance ——“ 533 .‘ ' )
Displays/specifies the : a aa i | _Image recording quality
white balance. Displays/specifies the image
E@:I \V +‘ L % recording quality.

Metering mode | Save destination display
e | LBt 1° "SR e*1o B8 || Disolaystho destnation oiderto

which images will be saved.
mode. (When you click the [Save also

on the camera’s memory card]
checkbox, the camera/PC icon is

Exposure compensation

Displays/specifies the exposure
compensation value.

Drive mode

Bracket shots —]

Displayed when any of

displayed, and when you
uncheck the checkbox, the PC
icon is displayed.)

Displays the drive mode.

WBB/AEB/FEB is
specified.

oo |‘_'] ONE SHOT—AF mode

§ & 33

Displays the AF mode.
— Shots to Go

Battery status —— 1

When you are using a battery,

[ fmmw] ] is displayed. When you
are using the AC Adapter Kit

(optional) or DC Coupler Kit, [ § ]
is displayed.

Warning display

*

information needed is displayed.

Displays the number of available
shots.

Displayed when the remote shooting is impossible due
to inappropriate settings.

The above window shows all the information at once. In actual use, only the
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Specifying the Camera Settings

Click the icon.

© The icon displayed here shows
exposure compensation as an
example.

Use the button to change a value.

Minimum settings button Maximum settings button
Specifies the minimum vallue. Spelciﬁes the maximum value.
OXO) ? Q)
1-step down settings button 1-step up settings button

Allows you to decrease the value by 1 step. Allows you to increase the value by 1 step.
=» The changed settings are applied to the camera.

0 © Before you specify the settings, be sure to check that the camera is ready for
shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you
cannot make some of the settings.

© Set functions which you cannot set with EOS Capture (drive mode, AF mode etc.) in
the camera.
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White Balance Adjustment

Specifying the Camera Settings

You can compensate white balance with the blue/amber/green/magenta digital filter.

© |If the dialog box has not appeared, click the [P] button.

Click the compensation position.

Compensate green.

AZ

G3

Displays the
compensation value.

G
1

Compensate blue. B H—'—H- A
E el

—— Compensate amber.

Compensate magenta.

-» The changed settings are applied to the camera.
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Specifying the Camera Settings

Specifying the Save Destination

You can specify save destination files and file names.

Select the [File] menu P> [Save destination setting].

=» The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Save settings dialog box

Allows you to change the destination folder to which images

Clicking the checkbox also saves images will be saved. The name of the destination folder is displayed
on the memory card in the camera. next to the [Browse] button.
Saree LETINGS

St b ARl
Macmasosh HO:Phote: OO ANON  wrowse.. )

| S ahis B the camera’i memary card

mm—— Use this field to enter a file name when
= saving an image. The file name can
Filenaene (op to LB characten Image. —— consist of up to 18 characters.
Fubenaere 1tast number ] [ Enter a sequential number with a range of
0000 to 9999 that is added to the end of
Rosies Image = -— the file name.
Ll On

Cond 3 o)

Applies the settings and closes the [Save settings]
dialog box.

Cancels all the settings, and restores the settings to
their original ones.

Click the checkbox to enable use of the rotation function (M-55).
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Troubleshooting and
Uninstallation

This chapter provides troubleshooting and describes the software
uninstallation procedures.




Troubleshooting

When the “Communication between the camera and computer failed” or “Software not running
correctly” message appears, check the items described below.

| have installed the software but the camera and
computer cannot communicate.

Does your computer comply with these requirements?
- A Macintosh with a USB connector as a standard feature.

* Operation is not guaranteed when the camera is connected to an interface that is not a
standard feature of Macintosh.

Are the camera and computer connected correctly?
- Connect the camera to your computer correctly using the dedicated cable (M-9).

Is the correct communication mode selected on the camera?

- When using the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D DIGITAL, set the
camera’s communication mode to [Normal] (M-8). With the EOS 10D, you must also
change the firmware to version 2.0.0 or later. For details on changing, see the Canon
website.

Is there sufficient charge left in the camera battery?

- Your computer does not supply power to the camera. With the EOS 20D, EOS 10D and
EOS DIGITAL REBEL/300D DIGITAL, connect to the camera with an AC Adapter Kit
(optional). With the EOS D60 and EOS D30, connect to the camera with the DC Coupler
supplied. Or, load a fully charged battery into the camera before connecting it to your
computer.

Do you have more than one camera connected to your computer?

If you connect more than one camera to the same computer, the driver and camera may not

operate normally.

- Quit the software and disconnect all the dedicated cables. Then connect only one
camera to the same computer again.

Are you using a first-generation iMac without having updated the firmware?
Update the firmware using the iMac Firmware Update.
- Download the iMac Firmware Update from the Apple website.

M-64



Troubleshooting

The software doesn’t run properly or doesn’t run at all.

@ Is the preferences file for the software corrupted?
- The preferences file for your software may be damaged.

Quit all active programs, delete the [Canon CameraCom Pref] file and the preference
files for the software you are using from the [Preferences] folder, and then restart the
software.
For OS X, double-click the startup disk P> click the [Home] button B double-click the
[Library] folder B> [Preferences] to open the [Preferences] folder and delete the target
preference files.
For OS 9, double-click the startup disk P the [System Folder] B the [Preferences] folder
to open the [Preferences] folder and then delete the target preference files.

* EOS CameraCom Pref Preferences file shared by all software programs for
communications (OS X only)

» CanonEOSViewerUtility Pref ~ Preferences file for the EOS Viewer Utility

* EOS Viewer Utility.plist

» com.canon.EOS Capture.plist Preferences file for the EOS Capture (OS X only)

» PhotoStitch Pref Preferences file for the PhotoStitch
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Uninstalling the Software

The following explanation uses the procedures for uninstalling the EOS Viewer Utility as an
example for uninstalling other programs as well.
The software uninstallation procedure is the same for both OS X and OS 9.
Before beginning the software uninstallation, quit all programs you are using and disconnect
the dedicated cable from your computer.
When you have moved the folders and the software to be deleted to the Trash, select
[Empty Trash] from the [Finder] menu (For OS 9, select [Empty Trash] from the [Special]
menu.) and empty the Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.

Open the [Canon Utilities] folder.

LT

Drag the folder for the software to be uninstalled to the Trash.

Select the [Finder] menu on the desktop » [Empty Trash].

For OS 9, select the [Special] menu P [Empty Trash].
The software is deleted.
When uninstallation ends, restart your computer.

0 You cannot retrieve data which you have moved to the Trash and deleted. Be particularly
careful when deleting data.
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